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Before You Begin

Welcome to SpiceMASTER™ 2.5 PRO

Welcome! This help guide holds everything you need to know about Pixelan Software's SpiceMASTER PRO 2.5. Although SpiceMASTER is powerful, it does not have a
steep learning curve −− a key benefit. Thus there is no need for a thick manual or training tape, or a large time investment by you to use it effectively. (Hooray!) The easy,
enjoyable way to learn is to step through this concise guide with SpiceMASTER visible on your screen.

To see how to APPLY SpiceMASTER PRO 2.5, view the Please Read FIRST file in your Start > Program Files > Pixelan > SpiceMASTER 2.5 menu. For a two−page
SUMMARY of all SpiceMASTER essentials, see the printable Quick Start in the same Start menu. We highly recommend that you look both documents over −− it will
SAVE you time!

How to Use This Help System
This help guide includes basic info, tutorials, and advanced tips. To access this help while using SpiceMASTER, click the ? button at the top right corner of the
SpiceMASTER window, or in the Library's toolbar. (Both are shown below.) Then click any control where you need help.

Or (anytime) choose Help from your Windows Start > Program Files > Pixelan > SpiceMASTER 2.5 menu.

Throughout the help pages, hot links are provided to related topics. Words in this color are commands, buttons, or areas in the SpiceMASTER interface. To browse
through topics, click any section at the left of this page, or click Contents atop this window. Or, click Index at the left (or top) of this page to see ALL entries for a topic.

Effect Examples
SpiceMASTER 2.5 PRO gives you eight unique visual effects capabilities:
• Hundreds of USEFUL Soft/Organic Customizable Transitions
• Soft/Organic/Animated Reveals of Lower Tracks
• Customize/Animate ANY Other Video Effects in Your Editing System
• 400+ Award−Winning OrganicFX™ Spices
• The MIXER for FILM Dissolves and Much More
• Soft/Organic Effects for Titles & Graphics
• Unique Animated/Soft/Organic PIPs
• Powerfully Enhance Black & White Mattes

Please click here to see many example images and movies at our web site. You also can view many more example effects via the HUNDREDS of cool saved settings and
modular presets built into SpiceMASTER. (Click here to see how easy it is.)

The DEMO Version
If you have a demo, you can explore SpiceMASTER for an unlimited time. The SM2.5 PRO demo is identical to the purchased version EXCEPT all effects have an X over
their image, and new saved settings cannot be created. Also, OrganicFX spices can only be viewed in the Library, not applied. Depending on your version, a SM 2.5 TFX
demo may have also been installed and will appear as a second Pixelan SpiceMASTER 2.5 item in your editing program's effects and transitions list. TFX is a low−cost,
basic version of SpiceMASTER. Please try both the TFX and PRO demos to see which one is most appropriate for your editing needs. For a detailed comparison between
TFX and PRO features, please click here.

Registration
If you purchased directly from Pixelan Software, you are ALREADY registered with us −− there is NO need to register. If you purchased from a reseller, please register at
http://www.pixelan.com/help/register.htm online. By registering, you will be informed by email about the latest SpiceMASTER updates as they arise, and you will receive the
guaranteed BEST prices on upgrades and future products.

Technical Support
We are dedicated to providing superb support. If you experience a problem, first look over the Please Read FIRST text file in your Windows Start > Program Files > Pixelan
> SpiceMASTER 2.5 menu. Common questions are answered there. For prompt further assistance, visit http://www.pixelan.com/help/techsupport.htm for help. From there,
you can submit an help form that we will answer promptly by email, usually within a few hours.

Enjoy SpiceMASTER PRO 2.5!
Sincerely,
Pixelan Software LLC, Bellingham, Washington, USA

© 2005 Pixelan Software LLC. All Rights Reserved. Pixelan Software and SpiceMASTER are trademarks of Pixelan Software LLC. All other products mentioned are for
identification purposes only and may be trademarks or registered trademarks of their respective owners.

This guide, as well as the software described in it, is furnished under license and may only be used or copied in accordance with the terms of such license. The information
in this guide is for informational use only, is subject to change without notice, and should not be construed as a commitment by Pixelan Software LLC. Pixelan Software LLC
assumes no responsibility or liability for any errors, omissions, or inaccuracies that may appear in this Guide.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic,
mechanical, recording, or otherwise, without the prior written permission of Pixelan Software LLC.

Most video clip images used in this guide are from the terrific royalty−free stock footage collection offered by www.creatas.com

Special thanks to our amazing code wizard Ivan Ivanov for making SpiceMASTER's magic possible!

next page
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Basic Steps

Introduction

This section walks you through the basics of applying and customizing SpiceMASTER. Although SpiceMASTER's intuitive interface gives you easy access to its deep
power, please spend a few minutes to explore this section (ideally with SpiceMASTER open on your screen). After all, you don't want to miss the many cool features and
conveniences we've included in SpiceMASTER!

1. Apply SpiceMASTER in Your Timeline
2. Choose a Spice File
3. Flip, Reverse, Move, or Rotate the Effect
4. Modify With the Amazing MIXER
5. Fine−Tune and Enhance the Effect

• Softness • Texture • Border • Shadow/Glow • Bevel/Ripple
6. Preview REAL−TIME
7. Apply or Clear the Effect

Click here for a basic tutorial that summarizes the above steps.

While exploring, keep these tips in mind:

• To loop−play SpiceMASTER while adjusting effects, click the blue Play button. This can speed fine−tuning.

• To choose from a huge collection of saved settings that will instantly configure ALL controls of SpiceMASTER, click the blue Load Saved Settings button.

• To access useful presets for an effect section, click the light−bulb at the right edge of any section. Combining presets from different sections can quickly generate
hundreds of new effects!

• SpiceMASTER has 100+ undo/redo's available so you can easily experiment. To undo one or more changes, click the yellow Undo button (or tap  Ctrl−Z keys). To redo
the change, click the adjacent green Redo button (or tap Ctrl−X keys). If either is not available, the button will be dim.

• To see how to change SpiceMASTER's default transition or effect, click here.

next page
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Basic Steps

1. Apply SpiceMASTER in Your Timeline

Applying SpiceMASTER in the timeline of your video editing software is much like applying built−in effects. To see the steps, click the video editing software below that you
use.
Adobe Premiere Pro
Adobe Premiere 6.x
Avid
DPS Velocity
Pinnacle Liquid Edition
Sony Vegas
Ulead MediaStudio

How to Apply in Adobe Premiere Pro

As a transition: From the Effects window (Video Transitions > Pixelan folder), drag SpiceMASTER 2.5 onto a cut point between two clips in any track (as shown below) or
onto the beginning or end of a single clip. The SpiceMASTER interface will appear. Click here for next steps.

As a video effect: From the Effects window (Video Effects > Pixelan folder), drag and drop SpiceMASTER 2.5 onto a clip. SpiceMASTER's interface will then appear. Click
here for next steps. The video effect will softly/organically reveal ANY content in lower tracks, unlike the SpiceMASTER transition which will reveal an overlapping clip in the
same track.

To animate OTHER Premiere Pro video effects in a clip: Sync two copies of the SAME clip in adjacent tracks Ñ one clip directly above the other copy. Next, apply the
Premiere Pro video effect(s) you want to animate, such as Color Balance, to just one clip copy. Then apply the SpiceMASTER video effect (as described above) to the TOP
clip. The video effect(s) will then appear only where the SpiceMASTER effect flows, as shown in the example below.

TIP: To set SpiceMASTER as the default transition (good idea), select SpiceMASTER 2.5 in the Effects window, then choose the Set Default Transition command in the
window's menu.

How to Apply in Adobe Premiere 6.x

As a transition: From Premiere's Transitions palette (3rd Party section), drag SpiceMASTER 2.5 between two overlapped clips in Track 1A and 1B. The SpiceMASTER
interface will then appear. Click here for next steps.

As a video effect: Select a clip in Track 2 or higher and turn on the Alpha Channel key. (In Premiere 6.x click the Setup button for Transparency in the Effect Controls
palette. Or right−click the clip and choose Video Options > Transparency. Select the Alpha Channel key type; click OK.) Then drag SpiceMASTER 2.5 from the Video palette
(Pixelan section) onto the clip. SpiceMASTER's interface will then appear. Click here for next steps. The clip effect will softly/organically reveal content in lower tracks, unlike
the SpiceMASTER transition which will reveal overlapping clips in Track 1.

To animate OTHER Premiere video effects in a clip: Sync two copies of the SAME clip in adjacent tracks; one clip directly above the other. Next, apply the Premiere
video effect(s) you want to animate, such as Color Balance, to just one clip copy. Then apply the SpiceMASTER video effect (as described above) to the TOP clip. The
video effect(s) will then appear only where the SpiceMASTER effect flows within the image, as shown in the example below.

TIP: To set SpiceMASTER as the default transition in Premiere 6.x (good idea), use the Set Selected as Default command in Premiere's Transitions palette.

How to Apply in Avid (any model except DS)

As a transition: Choose Pixelan in the left side of the Effect Palette, then drag SpiceMASTER 2.5 TFX from the Effect Editor onto a transition between two clips. (Be sure to
adjust the transition duration as desired.) Next, click SpiceMASTER's Effect Mode button in the Effect Editor. The SpiceMASTER interface will then appear. Click here for
next steps.
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As a segment effect: Use the same technique as above, but drag SpiceMASTER 2.5 TFX onto a video segment instead of a transition. Then SpiceMASTER can
organically reveal content in lower tracks.

To animate OTHER Avid segment effects: Sync two copies of the SAME clip in adjacent tracks Ñ one clip directly above the other copy. Next, apply the segment effect(s)
you want to animate to just one clip copy. Then apply the SpiceMASTER 2.5 segment effect (as described above) to the TOP clip. The clip effect(s) will then appear only
where the SpiceMASTER effect flows within the image (see the similar example shown above for Adobe Premiere). Click here for next steps.

TIP: To achieve near−real−time previewing on Avid systems, SpiceMASTER by default will show only a SINGLE frame of each clip in the built−in preview. To play ALL
frames of video content during the effect, Ctrl−click the blue Play button, or turn OFF the No image update option in the Prefs pane of SpiceMASTER. (Note: To preview all
frames in older Avids that only support AVX 1.0 (Media Composer v8, Xpress v2, Symphony v1, and Avid DS v4), you will have to preview from the Avid timeline.)
TIP: Where "SpiceMASTER effect" is mentioned in this guide, for Avid this means applying SpiceMASTER as a segment effect.
TIP: To save a particular SpiceMASTER effect for later use, set up the effect in the Effect Editor, then drag the SpiceMASTER icon into a bin. (You can rename it there by
clicking on the name.) To save a SpiceMASTER segment effect and its source media, do the above step but Alt−drag the effect into a bin.

How to Apply in DPS Velocity

As a transition: Right−click a transition icon in your timeline, then select Rendered Transitions > Plugin Transitions. In the dialog that will appear, choose SpiceMASTER
2.5; then click the Custom button in the Transition Viewer. The SpiceMASTER interface will then appear. Click here for next steps.

As a filter: Right−click a clip and choose Video Effects; then choose Filter Categories > General Plug−ins in the Apply Effects dialog. Click SpiceMASTER 2.5 in the
Available Filters list, then click Add. The SpiceMASTER interface will then appear. Click here for next steps. The filter will softly/organically reveal content in lower tracks,
unlike the transition which will reveal an overlapping clip in the same track.

To animate OTHER Velocity filters: Sync two copies of the SAME clip in adjacent tracks; one copy directly above the other. Next, apply the filter(s) you want to animate to
one clip copy. Then apply the SpiceMASTER 2.5 filter (as described above) to the TOP clip. The filters will then appear only where the SpiceMASTER filter flows within the
image. 

TIP: To save a particular SpiceMASTER effect for later use, set up the effect, then click the Save FX Macro button in the Apply Effects window. A new .flt file will be created
that you can load by clicking the Load FX Macro button.

How to Apply in Pinnacle Liquid Edition

As a transition: From the FX tab of the Project window or Browser, choose Plug In Transition FX > Added, then drag SpiceMASTER 2.5 onto the cut point between two
adjacent clips in the same track. Right−click that transition, then elect Edit. The SpiceMASTER interface will then appear. Click here for next steps.

TIP: Make sure the playback icon is ON for the track you are applying SpiceMASTER in, otherwise the effect will not be accessible. Also make sure the two clips you are
transitioning have been trimmed to allow their content to overlap during the transition.

As a clip effect: From the FX tab, apply Clip FX > Keying Editor onto a clip that is above other track(s) of content you want to softly/organically reveal with SpiceMASTER.
In the Keying Editor controls, for Key Type choose Chroma Key (with no settings). Now in the Project window or Browser, choose Plug In Clip FX > Added, then drag
SpiceMASTER 2.5 onto the same clip. Right−click the * button in the clip and choose Edit. (Or right−click the clip and choose FX Properties, then double−click
SpiceMASTER 2.5.) The SpiceMASTER interface will then appear. Click here for next steps.

TIP: SpiceMASTER must be above Keying Editor in the clip's effect order or the effect will not appear on playback.
TIP: To repeat a SpiceMASTER effect, right−click the effect icon in the right upper corner of the first clip you applied it to, then select Copy. Then apply it to any other clip.
To open a new project with pre−built favorite SpiceMASTER effects already on hand, in the Start > Projects menu save a project with the SpiceMASTER effects (and other
often used elements) as a template. Then choose that template when you create a new project.

To animate OTHER Liquid Edition clip effects: Sync two copies of the SAME clip in adjacent tracks Ñ one clip directly above the other copy. Next, apply the clip effect(s)
you want to animate to just one clip copy. Then apply the SpiceMASTER 2.5 clip effect (as described above) to the TOP clip. The clip effect(s) will then appear only where
the SpiceMASTER effect flows within the image, as shown in the example below.

How to Apply in Sony Vegas

As a transition: Overlap two events in the SAME video track, automatically creating a crossfade transition, as shown below.
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"Expanded" track view "Collapsed" track view

Then drag Pixelan SpiceMASTER 2.5 from the Transitions (or Plug−Ins) window/pane onto the crossfade. Or right−click the crossfade and choose Transition Properties,
then double−click Pixelan SpiceMASTER 2.5. In the Event FX window for SpiceMASTER that will appear (shown below), make sure the Sync Cursor button is off, then click
Open. SpiceMASTER's full interface will appear. Click here for next steps.

TIP: To preview in Vegas while making adjustments in SpiceMASTER, just click in your Vegas timeline. The Vegas preview will instantly update. You also can loop play
real−time in the Vegas timeline over a SpiceMASTER effect while making adjustments Ñ highly recommended and very cool!

As a video fx: Drag and drop Pixelan SpiceMASTER 2.5 from the Video FX (or Plug−Ins) window/pane onto an event in the timeline. Or, click the Event FX button in an
event's timeline icon, then choose Pixelan SpiceMASTER 2.5 in the Plug−In Chooser dialog. In the Event FX window for SpiceMASTER that will appear (shown above),
make sure the Sync Cursor button is off, then click Open. SpiceMASTER's full interface will appear. Click here for next steps.

To animate OTHER Vegas video fx: Sync two copies of the SAME clip in adjacent Vegas tracks Ñ one clip directly above the other copy. Next, apply the video fx you want
to animate to just one clip copy. Then apply the SpiceMASTER 2.5 video fx (as described above) to the TOP clip. The video fx will then appear only where the
SpiceMASTER effect flows within the image, as shown in the example below.

TIP: Like other video FX in Vegas, you can drag SpiceMASTER onto a track (the effect will apply to every event in the track), a media file (the effect will apply to every
instance of the file in a project), or a project (the effect will apply to every event in the project). Please see your Vegas manual for details if you are unfamiliar with this Vegas
feature.

TIP: Vegas also has its own Presets submenu atop SpiceMASTER to save effects, which can be applied directly from the Transitions or Video FX tab without opening
SpiceMASTER. To save a Vegas preset, first set up the SpiceMASTER effect as desired, then click SpiceMASTER's green Apply Current Settings 'check mark' button to
OK the effect. Then enter a name in the Presets submenu above SpiceMASTER and click the adjacent disk icon to save the preset. Thereafter, it will be available in the
Presets submenu and also appear graphically in the Transitions or Video FX tab after you click Pixelan SpiceMASTER 2.5 in the tab's list.

How to Apply in Ulead MediaStudio

As a transition: From the Transition Effect > Pixelan section of the Production Library, drag and drop SpiceMASTER 2.5 into the Fx track between overlapped clips. Then

click Options in the Transition Options dialog. The SpiceMASTER interface will then appear. Click here for next steps.

As a filter: (Not possible with the current MediaStudio plug−in architecture.)

To animate OTHER MediaStudio filters: Sync two copies of the SAME clip in Tracks Va and Vb Ñ one clip directly above the other copy. Next, apply the filter(s) you want
to animate to just one clip copy. Then apply the SpiceMASTER transition (as described above) between the clip copies. The filters will then appear only where the
SpiceMASTER transition flows within the image.

next page
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Basic Steps

2. Choose a Spice File

Each 'spice' file is a specially−designed grayscale map that guides SpiceMASTER. The SpiceMASTER effect will begin where blackest pixels reside (in the spice file's
image, not your content), then proceed to where lighter grays reside, and finally end where the whitest pixels exist in the spice image. It's simple in concept but incredibly
flexible and organic in its creative possibilities compared to the usual hard−edged, limited−adjustment, standard algorithmic effects.

Although conceptually similar, spices are quite unlike the typical gradient or alpha wipe. Spice designs are wonderfully organic and useful instead of cheesy. Spices
collectively have thousands of hours of pixel−by−pixel fine−tuning for studio−quality, ultra−smooth performance. And in SpiceMASTER, spices become far more than 'just'
transitions due to SpiceMASTER's power and versatility.

How to Choose a Spice File

1. Click the large Choose Spice File button located at the top middle of SpiceMASTER. SpiceMASTER's Library window will then appear.

2. Click a subfolder in the Library's left pane, as shown below. Thumbnail−size previews of available effects will then play side−by−side in the right pane so you can
visually compare and choose the best effect design for your segment.

Note: To see subfolders, click the "+" next to a folder in the left pane, if necessary. Subfolders organize SpiceMASTER's huge quantity of effects into distinct styles.

3. Double−click a thumbnail in the Library's right pane to select the effect and close the Library. The grayscale image of the chosen spice will appear at the top center of
SpiceMASTER, and its file name will be in the Choose Spice File button. SpiceMASTER's built−in preview will also immediately update to the effect. Or, single−click a
thumbnail to load the effect while keeping the Library open. Then you can try different spices "live" while loop−previewing within SpiceMASTER! It's a powerful way to
compare and match spice effects to your content.
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Click here for next steps.

Tips

• Use the Mixer slider to modify the spice's geometry partially or entirely by the luminance of your clip. This powerful new feature can quickly produce an enormous
new range of spice effects, including  FILM dissolves and terrific spice variations that visually tie to your clips. Try the slider and see for yourself! For more details, click here.

• To quickly choose a spice you have used recently, click on the Prior Choices area below the Choose Spice File button. Up to nine prior choices will appear in a pop−up
list −− most recent first. (Note: "Prior choices" are those that have been selected and applied in SpiceMASTER, not just viewed from the Library.)

• To choose a spice but bypass the Library, Ctrl−click the Choose Spice File button to get a standard Open dialog box. Then navigate to and select the file. This is
how you can load a gradient/alpha wipe or black & white matte you have created (or have from other software) that you may not want to keep in the Library. (To see how to
add a new file to the Library, click here.) For tips about creating such custom files, click here.

• To combine spice designs to create a 'new' spice effect, apply the SpiceMASTER  effect more than once to the same clip, but choose different spice files each time (or
invert, flip or move the same spice). This technique multiplies the spices in SpiceMASTER into an near−infinite range of effect designs!

• SpiceMASTER opens with a default effect. To change the default to a different effect, choose a spice and adjust the effect as desired, then click the Set button in the
Prefs pane. The new default will appear the NEXT time you apply SpiceMASTER.

next page
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Basic Steps

3. Flip, Reverse, Move, or Rotate the Effect

After choosing a spice file, it will appear at the top center of SpiceMASTER. Then you can adjust it several ways, such as flipping or reversing the effect, moving it to a new
position, or putting it in motion. You can even rotate it and create terrific spin effects. Use these controls to better tie the effect to your content, or to add variety when
repeating an effect.

A. Position −− Drag the orange handle's center to move the effect. To move ONLY horizontally/vertically, Shift−drag.

B. Rotate −− Drag the outer circle of the orange handle to rotate the effect.
C. Center (Alt−5) −− Click to re−center a moved effect.
D. Clear Rotation (Alt−6) −− Click to remove rotation from a rotated effect.
E. H Flip (Alt−7) −− Flip the effect horizontally.
F. V Flip (Alt−8) −− Flip the effect vertically.
G. Invert (Alt−9) −− Reverse (invert) the effect's action.

Original versus reversed effect with the Invert button. The effect moves in the opposite direction.

More tips are below:
Switching Clips in SpiceMASTER
More About Moving an Effect
How to Rotate or Spin the Effect
Spice Adjustment Tips

 Switching Clips In SpiceMASTER

• To switch clips in a SpiceMASTER effect (not transition), turn on the Invert button (shown above) AND choose the downward−sloped Completion Preset in the upper
right corner of the Keyframes area. (To switch clips in a SpiceMASTER transition, use the transition controls in your video editing software.)

The SpiceMASTER effect direction remains the same; just which clip appears first/last changes.
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More About Moving an Effect

• To set a precise position, enter X and Y coordinates under the spice image, as shown below. The top left frame corner is 0,0 and the bottom right corner is 1,1. To
position an iris spice effect precisely at the top left third point, for example, enter X = .33 and Y = .33.

• To move the effect over time…
1. Turn on a keyframe light next to the X or Y box. (Both will turn on together.)

2. Go to a desired frame that you want to set a rotation value for, by dragging the blue vertical frame marker in the Keyframes area. (Or use any of the gray playback buttons
under SpiceMASTER's preview to move to a frame. Or enter a frame number to the left of those buttons.)

3. Now move the spice to a new position, as explained at the top of this page. With the X/Y keyframe lights on, that will form a new keyframe, which you can further modify in
the Keyframes area.

How to Rotate or Spin the Effect

To rotate the effect, drag the outer ring of the orange handle in the spice file image. Or enter a rotation value in the R box below the image. From −3600 degrees to 3600
degrees is possible (20 full rotations in either direction).

To remove rotation, click the Clear Rotation button. (Or tap Alt−6 keys.)

To rotate or spin the effect over time…
1. Turn on the keyframe light next to the R box.

2. Go to a desired frame that you want to set a rotation value for, by dragging the blue vertical frame marker in the Keyframes area. (Or use any of the gray playback buttons
under SpiceMASTER's preview to move to a frame. Or enter a frame number to the left of those buttons.)
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3. Now rotate the spice, as explained at the top of this page. With the R keyframe light on, that will form a new keyframe, which you can further modify in the Keyframes
area. Be sure to also turn on the Oversize to Spin button (shown below) if you are using an iris−like spice to keep the spice size consistent during spins.
(SpiceMASTER normally will slightly vary a rotated spice's size to cover the entire frame.)

Spice Adjustment Tips

• Note that iris−like spices enlarge slightly as you move them toward the frame edge −− to ensure the spice effect will cover the entire frame.

• Moving or rotating certain spices may reduce the range of grayscales in the visible frame. Thus the effect will not start or end exactly at the actual beginning or end of
the effect. To compensate (especially if an iris−like effect), turn on the Auto−Adjust button. Applying some Softness can also be useful, especially for effects that last several
seconds.

If the results are not satisfactory, turn off the Auto−Adjust button and manually adjust the effect's first (and/or last) Completion keyframes up (and/or down) (such as 20%
− 80% instead of the default 0% − 100%) to fine−tune the effect's visual timing.

Click here for the next step of applying SpiceMASTER.
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Basic Steps

4. Modify With The Amazing MIXER

Looking for a true film look? Even if you have a film−look plug−in for adding grain, you're not all of the way there without also being able to apply true FILM dissolves.
SpiceMASTER 2.5 PRO solves that need with its powerful new MIXER control. Even better, the MIXER synergizes film dissolves with the unique power of spices. That
means you can also apply DIRECTIONAL film dissolves −− an industry first and a very useful new capability for videographers and filmmakers! Plus, the MIXER
enhances SpiceMASTER's other creative capabilities. So you can easily form custom effect animations and terrific spice variations that visually tie to your clips!

How does the MIXER work? It variably alters (via a keyframable slider) any spice effect you choose with the luminance in your clips. Simple in concept, but extremely
powerful in use. Note that the MIXER is keyframable. For more details about SpiceMASTER's powerful keyframing, click here.

Below are a few examples of this "must have" new feature. But keep in mind the examples don't really do it justice −− please try the MIXER slider for yourself!

Above is a soft elliptical reveal by SpiceMASTER, positioned over the pupil to animate a color effect softly outward.

With the MIXER blended in at 50% strength, the reveal still starts at the pupil but now also softly diffuses into nearby darker pixels of the clip, like a film dissolve.

Inverting the MIXER blend diffuses the spice effect into nearby lighter areas of the clip, creating yet another useful variation. Since the MIXER is adjustable with a slider (and
keyframable), you can variably blend its strength with the spice effect's geometry.

A second example: a subtle, elegant SpiceMASTER directional dissolve, which has always been a great alternative to standard dissolves. This one originates from the top
right corner.

With the MIXER blended in, now the dissolve spreads first into the darker pixels in the phaoroh image, much like a film dissolve.

Inverting the MIXER creates a dissolve variation that spreads into lighter pixels first.

Click here for the next step of applying SpiceMASTER.
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Basic Steps

5. Fine−Tune & Enhance the Effect

After you set the basic design of the spice effect by choosing a spice file, SpiceMASTER can do much more to fine−tune and enhance it. Use the powerful controls in the
Edge and Depth panes to add softness, texture, border, shadow, glow, bevel or ripple qualities. Click each one below for details and techniques.
• Softness   • Texture   • Border   • Shadow/Glow   • Bevel/Ripple

While exploring, keep these tips in mind:

• To loop−play SpiceMASTER while adjusting effects, click the blue Play button. This can speed fine−tuning.

• To choose from a huge collection of saved settings that will instantly configure ALL controls of SpiceMASTER, click the blue Load Saved Settings button.

• To access useful presets for an effect section, click the light−bulb at the right edge of any section. Combining presets from different sections can quickly generate
hundreds of new effects!

• SpiceMASTER has 100+ undo/redo's available so you can easily experiment. To undo one or more changes, click the yellow Undo button (or tap  Ctrl−Z keys). To redo
the change, click the adjacent green Redo button (or tap Ctrl−X keys). If either is not available, the button will be dim.

• To display two panes of SpiceMASTER controls at once (handy when combining effect enhancements), click the white triangle button in the top right corner of
SpiceMASTER.

• To see how to change SpiceMASTER's default transition or effect, click here.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Softness

Softness is a simple but compelling treatment that is creatively useful for many types of SpiceMASTER effects, including directional dissolves, title/effect animation, PIPs
and more. It is also one of SpiceMASTER's advantages over most standard video effects. Applying a spice hard usually doesn't cut it!

More examples

More about softness techniques are below:
How to Apply Softness
How to Vary Softness During the Effect
Tips

How to Apply Softness

To apply softness, drag the Standard or All Edges slider in the Softness section of SpiceMASTER's Edge pane until you have the desired look. Or enter a percentage
(from 0 to 100%) in the slider's box.

Use Standard softness to…
• Apply super−soft looks (its highest softness exceeds All Edges' highest).
• Soften only the active (moving) edge of a SpiceMASTER effect.
Use All Edges softness to…
• Soften all edges in SpiceMASTER effects −− active and inactive (see images below).
• Create the highest−quality slight or moderate softness.

Standard softness All Edges softness
For a wonderfully blended softness, try applying both types of softness.

How to Vary Softness During the Effect

For further creative flexibility, you can smoothly vary softness over time. You can gradually increase, decrease, or pulse softness during the effect , all of which create
unique looks. To vary softness over time, first click on the keyframe light next to the Softness slider you want to vary. The light will turn bright green.

In the Keyframes area, the keyframe graph for the above control will appear. Click on the keyframe line −− or click the gray Add Key (+) button at the top right of the graph
−− to add a new keyframe, then drag the keyframe where desired (higher is more softness).
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To add more keyframes, repeat as desired. For more details about SpiceMASTER's powerful keyframing, click here.

 Tips

• To access useful presets, click the light−bulb at the right edge of the Softness section.

• Fine−grained organic spice designs (such as those in the OrganicFX\Burst or OrganicFX\Texture folders of the Library) typically look best with only a small or moderate
amount of softness. High softness can lose the organic motion detail of such effects.

• The Softness sliders also modify SpiceMASTER's Texture and Bevel/Ripple effects. Separate softness controls are provided for Border and Shadow/Glow effects.

• Softness can smooth curved or angled edges, such as in rotated or moved spice effects.

• As the SpiceMASTER preview plays, you can adjust Softness settings interactively.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Softness

Softness Examples

View movie at our web site
A SpiceMASTER directional dissolve emerges from the upper left corner to softly reveal the sunset clip, providing a subtle movement and curvature in the dissolve to match
the arm action.

View movie at our web site
A very soft SpiceMASTER iris effect with a blue glow tracks the falling skier's movement, while revealing the abstract moving lights clip. Separately, SpiceMASTER has also
been applied to the title clip, to add a glow around the letters and to softly fade the title as it rolls to the left.

View movie at our web site
A softened OrganicFX Burst spice subtly adds "soft rays" to reveal the emerging athlete. The effect's center also is keyframed to move right slightly with the footage.

View movie at our web site
A softened OrganicFX spice is used to position, animate and reveal a filter effect within a single clip.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Texture

Texture provides additional organic edge control in your effect. It can add trailing sparkles, powders, visual noise, edge texture and animation to SpiceMASTER effects
(including PIPs). It can also build organic, cutting−edge new looks from existing spice effects.

More examples

More about texture techniques are below:
How to Apply Texture
How to Vary Texture During the Effect
Tips

How to Apply Texture

To apply texture, drag the Texture > Amount slider in SpiceMASTER's Edge pane to progressively increase the effect. Or enter a percentage (from 0 to 100%) in the
slider's box.

Then fine−tune the effect with:
X Size and Y Size to set the horizontal and vertical size of texture elements.
Scatter to progressively reduce the density of texture elements.
Motion to progressively add random movement/animation to the texture elements over time.

Try the many Texture presets −− by clicking the light−bulb at the right side of the Texture section. That will quickly show you many organic capabilities of Texture. Mix and
match with presets from other SpiceMASTER sections and various spice files to produce a huge variety of fresh effects! For more about presets, click here.

How to Vary Texture During the Effect

For further creative flexibility, you can smoothly vary Texture over time, such as to gradually 'materialize' a title, graphic, or background, or to increase organic qualities as an
effect progresses. To vary Texture settings over time, first click on the keyframe light next to the Texture slider you want to vary. The light will turn bright green.

In the Keyframes area, the keyframe graph for the above control will appear. Next, in the Keyframes area click on the keyframe line −− or click the gray Add Key (+)
button at the top right of the graph −− to add a new keyframe, then drag it where desired (higher is a higher slider value).
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To add more keyframes, repeat as desired. For more details about SpiceMASTER's powerful keyframing, click here.

Tips

• While the SpiceMASTER preview plays, you can adjust Texture settings interactively.

• Texture is a powerful way to animate existing OrganicFX spices, increasing their organic realism. Apply a slight amount of Texture animation to an OrganicFX\Textures or
OrganicFX\Climatics spice, for example. Experiment!

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Texture

Texture Examples

View movie at our web site
In this action scene, the snow−like texture elements reveal the skier in a very dynamic manner.

View movie at our web site
Texture combined with beveling provides a unique depth effect to the incoming ski clip.

View movie at our web site
Texture provides a sparkling shimmer to this organic transition's edge as it closes toward the subject. Also, the transparency of the first clip is subtly increasing during the
effect −− all via SpiceMASTER.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Border

SpiceMASTER's powerful Border controls can create multicolor gradient borders that can seamlessly change width, color, softness, opacity, and position over time. The
intuitive control shows a cross−section of the border, making fine adjustments easy. Adding a border can:
• visually separate transitioning scenes clearly when desired;
• more strongly define animated effect regions in an image;
• frame PIP (picture−in−picture) effects;
• create flowing motion−graphic effects within your NLE (see images below);
• create stunning abstract looks.

More examples

More about Border techniques are below:
How to Apply a Border and Adjust Thickness
How to Modify the Entire Border or a Point
How to Change the Border Color
How to Alter the Border Softness/Opacity
How to Alter the Border Position
How to Vary the Border During the Effect
Tips

How to Apply a Border and Adjust Thickness

To apply a border, drag the Type 1 or Type 2 slider in the Border section of SpiceMASTER's Edge pane until you have the desired border thickness. Or enter a percentage
(from 0 to 100%) in the slider's text box.

Use Type 1 to border…
• all edges in an effect −− active (moving) and inactive −− see the examples below.
• with a consistent thickness in any spice geometry.
• thickly in a more rounded/blurred style than Type 2.
• beyond a PIP's boundary.
Use Type 2 to border…
• only the active (moving) edge of an effect.
• while retaining the smallest edge details in SpiceMASTER's organic effects.

Type 1 border Type 2 border

How to Modify the Entire Border or a Point

The checkered Color/Opacity indicator represents the border in cross−section. The checkered edges represent semitransparent to transparent areas. Above it are three
adjustable control points that can create a wide variety of border looks. The active control point of the three is outlined in red, as shown below.
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To alter the color or opacity of a single control point (thus only part of the border width), first click on the point to activate it. It will then be outlined in red. Then
choose a color or drag the Opacity slider (or enter a value in the Opacity text box, from 0 to 255).

To alter the color or opacity of the entire border, Alt−click in the color palette or with the eyedropper. To change just the opacity of the entire border, Alt−drag the Opacity
slider.

Note you can drag the three control points left or right to further fine−tune the border. Moving a control point closer to the outside edge of the indicator will produce a
harder edged border. Moving outer control points toward the center will increase the border's softness. Moving two control points closer that have different colors or
opacities will create a sharper gradation of values.

To quickly transfer color/opacity from an active control point to an adjacent point, click either red triangle at the side of the control (circled below).

How to Change the Border Color

SpiceMASTER's initial default border color is white (you can change the default in the Prefs pane), but any color is possible, such as one that is already in your scene.
SpiceMASTER provides two ways to change the color.

To match the border color to a color in your scene, click the Eyedropper in the Color control, then click in the SpiceMASTER preview (as shown below) −− or anywhere
else on your monitor! To apply the color to the entire border width (not just an active control point), Alt−click the eyedropper.

To choose a color in the standard Windows color picker, click the Color palette, which includes an Other button for custom colors (see below). To apply a color to the
entire border width (not just a selected control point), Alt−click the color palette.

To create a multicolor gradient border, first click a control point, choose a color, then repeat for other points as desired.

How to Alter the Border Softness/Opacity

The chosen color will initially appear in the border with slight softness (thus less opacity along the edges). To increase (or decrease) the border's softness, drag one or
both outer control points inward (or outward). To further soften the look, you can also decrease the opacity of that control point. In the example below, both steps have been
done for the left control point, leading to a softer look in the top of the organic effect's border.
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To alter the entire border's opacity, Alt−drag the Opacity slider.

How to Alter the Border Position

By default, the border you create will extend along BOTH sides of the effect's edge. To have a border appear only inside or outside of the effect's edge, choose Inside
Edge or Outside Edge in the Border > Position submenu. Note this is the only Border setting that cannot change (i.e. be keyframed) during the effect.

Depending on other settings, choosing Inside Edge or Outside Edge may roughen the border along one side. To smooth that edge, apply some Softness.

How to Vary the Border During the Effect

For further creative flexibility, you can smoothly vary the border over time. By keyframing the Type 1 or Type 2 amount, for example, you can "vibrate" borders to a beat. Or

keyframe the border color to evolve it during the effect. To vary border width over time, click the keyframe light next to the Type 1 or Type 2 control (it will turn bright
green).

The keyframe graph for the above control will then appear. Click on the keyframe line −− or click the gray Add Key (+) button at the top right of the graph −− to add a new
keyframe, then drag it where desired (higher is more border width). To add more keyframes, repeat as desired.

To keyframe Color/Opacity over time, first click on the keyframe light next to the Color control −− it will turn bright green. (That light also keyframes Opacity.)

The keyframe graph for the above control will then appear. Click on the keyframe line to add a new keyframe, dragging it right or left until it is at the desired frame (it will
not drag up or down). Then use the Border > Color and/or > Opacity control to set the qualities of the new keyframe. To add more keyframes, repeat as desired. For more
details about SpiceMASTER's powerful keyframing, click here.
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Tips

• To access useful presets, click the light−bulb at the right edge of the Border section.

• To see how to add an animated border ALONE without otherwise changing a clip, click here. Instant flowing energy wave!

• While the SpiceMASTER preview plays, you can adjust Border settings interactively.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Border

Border Examples

View movie at our web site
A multicolor border to an OrganicFX spice becomes much of the effect during the transition, forming a simulated blast ray outward from the eye that fades away toward the
end of the transition. Note that the effect is also slowly tracking leftward with the eye as the statue pans left.

View movie at our web site
To accentuate the liquid−like geometry of the OrganicFX spice and theme, a soft, semitransparent white border radiates outward and grows stronger until the next clip is
revealed.

View movie at our web site
In this organic−shaped animated PIP (picture−in−picture) scene, the purple/white multicolor border (with a shadow) pulses into different colors during the PIP. This further
defines and accentuates the PIP's animated action.

View movie at our web site
A fire−like multicolor border effect in SpiceMASTER burns away the first clip to organically reveal the second clip.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Shadow/Glow

Placing a realistic shadow or glow along a SpiceMASTER effect's edge is easy. Such depth effects can:
• create the illusion of one image growing, flowing or eroding above another
• simulate thickness in an image (a powerful way to add depth);
• emphasize the dynamic edge of a spice effect or custom matte;
• create fresh PIP (picture−in−picture) looks;
• add a keyframable shadow to titles, graphics and backgrounds.

You can control several shadow qualities: shadow style, opacity, softness, color and depth. All but shadow style are keyframable.

More examples

More about shadow/glow techniques are below:
How to Apply a Shadow
How to Change the Shadow's Strength, Depth or Angle
How to Change the Shadow/Glow Color
How to Apply a Glow
How to Vary a Shadow/Glow During the Effect
Tips

How to Apply a Shadow

In the Shadow/Glow > Style submenu, select Under 1st clip, Under 2nd clip, or Border Only. The Border Only option only appears if a Border is also visible.

Under 1st clip creates a "cutaway" effect that shows the 2nd clip under the first clip. Under 2nd clip flows the second clip over the background image. Border Only floats a
border over the images.

Under 1st clip Under 2nd clip Border only

How to Change the Shadow's Strength, Depth or Angle

To adjust the shadow's strength, adjust the Softness and Opacity sliders. A soft, partially transparent shadow offset to the lower right and fairly deep is SpiceMASTER's
initial default. (To see how to change default settings, click here.)

To alter the shadow's position or angle, drag in the representative Shadow box next to the X Offset and Y Offset controls, watching the preview until you achieve the
desired depth and angle.

To constrain shadow movement to only horizontal or vertical, Shift−drag in the Shadow box. To make exact adjustments, enter values (from Ð1 to +1) in the text
boxes. An X,Y value of 0,0 is no offset.

How to Change the Shadow/Glow Color

SpiceMASTER's initial default shadow color is black, but any color is possible, such as a bright color for a glow, white for special lighting effects, or a scene color for an
abstract visual effect. SpiceMASTER provides two ways to change the color:
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To match the shadow or glow to a color in your scene, click the Eyedropper in the Shadow/Glow > Color area, then click in the SpiceMASTER preview −− or anywhere
else on your monitor! To choose a color in the standard Windows color picker, click the Color palette, which includes an Other button for custom colors.

How to Apply a Glow

You can create glows easily by applying a soft shadow with a bright color, then eliminating any offset (thus centering the shadow). To center the shadow for a glow effect,
click the adjacent Center button, as shown below.

To adjust the glow's style, choose Under 1st clip to create an inner glow, or Under 2nd clip to create an outer glow. If a thick border is in the effect, Border Only can visibly
glow in both directions around a border.

Under 1st clip Under 2nd clip Border Only

To adjust the glow's strength, adjust the Softness and Opacity sliders. Typically, high values for both will be most useful. To adjust the glow's color, use the tips
described above.

How to Vary a Shadow/Glow During the Effect

SpiceMASTER's powerful keyframing can add terrific dynamics to a shadow or glow. To smoothly change colors during the effect, for example, keyframe Color over time. To
make a shadow appear as if it is coming from a single light source or subject in your scene, keyframe the Offset over time. To pulse a glow, keyframe Opacity and/or
Softness over time.

To vary a shadow or glow over time, first click on the keyframe light next to a Shadow/Glow slider you want to vary. The light will turn bright green.

The keyframe graph for the above control will appear. Click on the keyframe line −− or click the gray Add Key (+) button at the top right of the graph −− to add a new
keyframe, then drag the keyframe where desired.
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To add more keyframes, repeat as desired. To keyframe color over time, first click on the keyframe light next to Color −− it will turn bright green. In the Keyframes
area, the keyframe graph for the above control will then appear. Click on the keyframe line to add a new keyframe, dragging it right or left if needed until it is at the desired
frame (it will not drag up or down). Then use the Color control to set the color for the new keyframe. To add more keyframes, repeat as desired. For more details about
SpiceMASTER's powerful keyframing, click here.

Tips

• To access useful presets, click the light−bulb at the right edge of the Shadow/Glow section.

• A hard shadow that is only slightly offset can add the illusion of thickness to a flowing image or effect.

• While the SpiceMASTER preview plays, you can adjust Shadow/Glow settings interactively.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Shadow/Glow

Shadow/Glow Examples

View movie at our web site
A blue glow around an organic iris effect complements and shapes the color balance effect that eventually fills the image.

View movie at our web site
The sunset shot is revealed with a drop shadow to add definition to the organic flowing form. Note that the second clip (and its shadowed edge) increase in opacity during
the effect −− all done in SpiceMASTER.

View movie at our web site
A drop shadow under the powdery border effect adds depth to the transition.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Bevel/Ripple

Placing a bevel or ripple along a spice effect's edge are further ways (besides Shadow/Glow) to add depth to SpiceMASTER effects. Such depth effects can:
• create the illusion of one image growing, flowing or eroding above another;
• simulate thickness in an image (a powerful way to add depth);
• emphasize the dynamic edge of a spice effect;
• create fresh PIP (picture−in−picture) looks.

More examples

More about bevel/ripple techniques are below:
How to Add a Bevel
How to Add a Ripple
How to Vary Bevel/Ripple During the Effect
Tips

How to Add a Bevel

To apply a bevel to a spice effect, select an option in the Bevel/Ripple > Style submenu. In, Out, Both, and Both Inverted are available.

Original effect In Out Both Both Inverted

To increase or decrease the bevel width, adjust the Displace slider. To increase or decrease the bevel highlights and shadows, adjust the Light slider. To change the
light angle, adjust the Angle slider. To increase or decrease the bevel softness, adjust the Softness slider. Note you can further modify the softness by using the MAIN
Softness sliders in SpiceMASTER, especially All Edges softness.

How to Add a Ripple

To add a ripple to a SpiceMASTER effect, follow the steps described above to apply a bevel edge. Then adjust the Waves slider as desired. Note that ripple(s) will appear
relatively tightly clustered around the spice edge unless you also increase the MAIN Softness sliders in SpiceMASTER.

Original effect Waves, no softness Waves + MAIN softness

Several ripple presets are available by clicking the light bulb at the right top of the Bevel/Ripple section.

How to Vary Bevel/Ripple During the Effect

For further creative flexibility, you can smoothly vary Bevel/Ripple over time, such as to gradually decrease ripple strength toward the end of an effect (like a real water
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drop). To vary Bevel/Ripple settings over time, first click on the keyframe light next to the Bevel/Ripple slider you want to vary. The light will turn bright green.

The keyframe graph for the above control will appear. Click on the keyframe line −− or click the gray Add Key (+) button at the top right of the graph −− to add a new
keyframe, then drag it where desired in the graph (higher is a higher value).

To add more keyframes, repeat as desired. For more details about SpiceMASTER's powerful keyframing, click here.

Tips

• To access useful presets, click the light−bulb at the right edge of the Bevel/Ripple section. For example, a water drop effect (as a transition or to animate another effect) is
a popular ripple effect that can be done with a simple SoftFX\Irises\Elliptic C spice and the Ripple4a preset.

Note that all Bevel/Ripple presets also affect MAIN Softness settings. Two Clear presets are available, as shown above −− one of which also clears the MAIN Softness
settings.

• While the SpiceMASTER preview plays, you can adjust Bevel/Ripple settings interactively.

next page
Step 4's Introduction
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Basic Steps

5. Fine−Tune & Enhance the Effect: Bevel/Ripple

Bevel/Ripple Examples

View movie at our web site
The classic water ripple effect elegantly done as a transition by SpiceMASTER.

View movie at our web site
An OrganicFX Fog spice combined with a bevel leads to this textured reveal.

View movie at our web site
Beveling can be applied to add depth to an incoming clip.

next page
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Basic Steps

6. Preview REAL−TIME

Initially, SpiceMASTER's preview shows a frame that is midway (50%) in the effect's duration. To play or stop the preview, click the blue Play button that is under the
preview (or tap the X key). To jump to the beginning or end of the effect, click the First Frame or Last Frame button (or tap the S or D key). To advance or go back one
frame, click the Next Frame or Previous Frame button (or W or E key).

To scrub to any frame during the effect, drag the blue vertical frame marker left or right in the keyframe graph. Or, hold down the E key.

To go to a specific relative frame via timecode or frame count (a choice you can make in the Prefs pane), enter the frame in the white Current Frame box that is left of
the preview buttons, as shown below.

How to Increase the Preview Speed

SpiceMASTER's built−in preview usually can maintain a real−time pace even on older/slower computers. If the preview appears too choppy, SpiceMASTER includes few

ways to speed processing up. Please see the preview options in the Prefs pane.

How to Alter Other Preview Properties

To reduce the preview's size to position PIP or title motion effects off−frame, right−click the preview and choose from the Size submenu. Scaling it smaller leaves a
surrounding area to drag an image or visual element off−frame.
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Or click the Preview Size button (shown below) at the top of the PIP+ pane to cycle through the choices.

To choose a different preview background for the SpiceMASTER effect (if available for your NLE), right−click the preview and choose from the Background submenu.
SpiceMASTER's default is a grid pattern, however you can choose black, white or gray. The SpiceMASTER effect preview will substitute the background instead of actual
content that being revealed by the effect.

To turn on/off the safe areas indicator, click the Show safe areas check box in the PIP+ pane. Knowing the traditional 'safe' titles and graphics regions of the frame (for
overscanned output on televisions) can be useful while setting up PIP or title moves.

To turn on/off the PIP+ handles, click the Show Handles check box in the PIP+ pane. Dragging the handles is a handy way to set up a PIP or title move. You can hide the
handles so they do not distract during previewing.

Tips

• Since SpiceMASTER's built−in preview is 240x180 pixels, it may not show an effect as cleanly as your final full−size output. And rectangular pixel content (i.e. DV, D1) will
be slightly squeezed or stretched. To see the effect most accurately, preview at final output size in your video editing software.

• SpiceMASTER also can preview real−time from the timeline of Adobe Premiere 6.5/Pro*, Sony Vegas, and Ulead MediaStudio 7. Also, it background renders in Pinnacle
Liquid Edition. *Certain RT video boards (i.e. Matrox) may require Premiere settings that defeat Premiere's native real−time previewing. In that case, SpiceMASTER's
built−in preview can still be real−time.

• The effect's total duration is shown to the right of the preview buttons. The total duration of a SpiceMASTER effect is set in the timeline of your video editing software, not
in SpiceMASTER. However, you can shorten an effect within that total duration by using SpiceMASTER's Keyframes area. Just choose the Completion Preset shown
below. Then drag the inner keyframes left or right to set the timing of the shortening.

If you already have other Completion keyframes set that you do not want to eliminate by choosing the above preset, you can manually do the above. In the
Completion graph, click on the keyframe line to add two new keyframes near the start and end of the effect, giving the keyframes 0% (and 100%) values vertically. Then
drag the keyframes left or right to set the timing of the shortening.

Click here for the next step.
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Basic Steps

7. Apply or Clear the Effect

Go to the black button bar at the lower right corner of SpiceMASTER to apply (or clear) your effect, or to exit SpiceMASTER.

To apply the effect you've created, click the green Apply Current Settings 'check mark' button.

To exit SpiceMASTER without changes, click the red Exit Without Changes 'X' button in the black bar. (Clicking the standard Close button at the top right of the
SpiceMASTER window also does this.)

To clear all settings back to your default SpiceMASTER effect, but retain the chosen spice file and NOT leave SpiceMASTER, click the yellow Clear '−' button. To clear
all settings except the chosen spice file to the "factory" default effect, Alt−click the yellow Clear '−' button. To also clear the chosen spice during either previously mentioned
clear, also press the Ctrl key.

Tips

• When exiting without changes, SpiceMASTER will ask you to confirm that action. To skip confirmation (be careful!), go to the Prefs pane and turn OFF the Confirm before
exiting w/o changes check box.

• To clear SpiceMASTER default settings back to the "factory" default, go to the Prefs pane and click the Clear button shown below. That button will NOT change the
current settings −− it will change what appears the NEXT time you apply SpiceMASTER. Clear also will not change SpiceMASTER's preference settings, which are retained
automatically when changed.

• To set a new default effect anytime, choose a desired spice file and adjust settings, then click the Set button.

• To see what version of SpiceMASTER you are using, click the Pixelan logo in the black bar area.

Go to the next section of this Guide
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Basic Steps

Basic Tutorial: Applying a SpiceMASTER Transition

1. Apply the SpiceMASTER 2 transition in the timeline of your video editing software. Click here for the specific steps. SpiceMASTER's dialog will then appear.

2. Open SpiceMASTER's Library. Click the large Choose Spice File button located at the top middle of SpiceMASTER. SpiceMASTER's Library window will then appear.

3. Choose an effect design. Click a subfolder in the Library's left pane, as shown below. The hundreds of effect designs are organized into subfolders by style. Then
double−click a desired effect design playing in the Library's right pane. Or SINGLE−click a thumbnail to load the effect into SpiceMASTER without closing the Library. By
keeping the Library open, you can switch spices while continuously previewing within SpiceMASTER! It's a powerful way to compare and match spice effects to your
content.

4. Adjust the effect. The grayscale image of the chosen spice will then appear at the top center of SpiceMASTER, and its file name will be in the Choose Spice File button.
Use the controls below to better position and tie the effect to your content, or to add variety when repeating an effect.

A. Position −− Drag the orange handle's center to move the effect. To move ONLY horizontally/vertically, Shift−drag.

B. Rotate −− Drag the outer circle of the orange handle to rotate the effect.
C. Center (Alt−5) −− Click to re−center a moved effect.
D. Clear Rotation (Alt−6) −− Click to remove rotation from a rotated effect.
E. H Flip (Alt−7) −− Flip the effect horizontally.
F. V Flip (Alt−8) −− Flip the effect vertically.
G. Invert (Alt−9) −− Reverse (invert) the effect's action.

5. Modify the effect's geometry with the amazing MIXER. The MIXER variably alters (via a keyframable slider) any spice effect you choose with the luminance in your
clips. Just drag the slider to see what looks best for your segment.

6. Set the effect qualities. After you set the basic design and position of the spice effect, SpiceMASTER can do much more to fine−tune and enhance it. Use the powerful
controls in the Edge and Depth panes to add softness, texture, border, shadow, glow, bevel or ripple qualities. Click each one below for details and techniques.
• Softness   • Texture   • Border   • Shadow/Glow   • Bevel/Ripple
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To access useful presets for any of the above, click the light−bulb at the top right edge of a control section, as shown below for Texture. Presets can be combined into
thousands of fresh effects!

To easily experiment with different settings, SpiceMASTER has 100+ undo/redo levels −− click the buttons circled below (or tap  Ctrl−Z / Ctrl−X keys respectively). If either
is not available, the button will be dim.

7. Preview. To play or stop the preview, click the blue Play button that is under the SpiceMASTER preview. Note you can play SpiceMASTER's preview continuously while
making adjustments −− even while changing spices! This can speed your fine−tuning of the effect.

8. Apply the effect. Click the green Apply Current Settings 'check mark' button.

Congratulations −− you are done!

next page
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Keyframing

Introduction

SpiceMASTER's powerful keyframer can smoothly vary virtually any control during an effect. You can accelerate, decelerate, hold, reverse, pulse, or set any special timing.
In the easy−to−use Keyframes graph of SpiceMASTER, keyframes can be moved and fine−tuned further as desired. By default, Completion (the effect's progress) appears
with a straight inclined line, as shown below. That means the effect will be linear −− it will progress at constant speed for its entire duration. The horizontal scale of the graph
represents duration, from 0% to 100%. The vertical scale represents the setting's value.

If a different graph than Completion is in your Keyframes area, click the Keyframes label to return to the Completion graph, as shown below. (For more graph−switching
shortcuts, click here.)

General Tips

• Before setting keyframes in SpiceMASTER, it is usually best to first make sure in your video editing software's timeline that the SpiceMASTER transition/effect's total
duration is what you desire.

• You can adjust keyframing while the SpiceMASTER preview is stopped or while the preview plays.

• To freely experiment with keyframe settings, use the Undo/Redo buttons in SpiceMASTER. SpiceMASTER has 100+ undo/redo's available. To undo a change, click the
yellow Undo button (or tap  Ctrl−Z keys). To redo the change, click the adjacent green Redo button (or tap Ctrl−X keys). If either is not available, the button will be dim.

• The maximum number of keyframes per control is 128. The maximum total number of keyframes for all controls is 1,000.

How to Add/Delete a Completion Keyframe
Common Completion Adjustments
Keyframing Other Controls
How to Move a Keyframe Precisely
Navigating in the Keyframe Graph
Accelerating or Decelerating An Effect
More Keyframing Tips
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Keyframing

How to Add/Delete a Completion Keyframe

To add a Completion keyframe, do any of the following steps:

Click on the Completion graph line to create a new keyframe. Then drag the keyframe to a desired position, as shown below. As you drag the keyframe, its coordinates
will appear in the top left of the graph, and the preview will instantly update.

OR, click the Completion Presets button and choose a keyframe profile. Eighteen are provided. After the profile appears in the graph, you can modify it further as desired.

OR, position the blue vertical playback marker near where you want a new keyframe (Step 1 below). Click the Add Key (+) button (see Step 2), then drag the keyframe
up or down to a desired value. (To constrain its movement horizontally or vertically, hold down the Shift key.)

To delete a keyframe, right−click it and choose Delete keyframe. Or, click the keyframe if it is not already active (it will appear brighter when active), then click the Delete
Key button (shown below).

Note: If you recently added the keyframe, you could also click SpiceMASTER's Undo button to revert to before that step. To delete ALL new Completion keyframes, click
the Completion Presets button to choose the default 0%−100% preset. Or click the keyframe graph's background area and choose Revert to default.

Introduction
> How to Add/Delete a Completion Keyframe
Common Completion Adjustments
Keyframing Other Controls
How to Move a Keyframe Precisely
Navigating in the Keyframe Graph
Accelerating or Decelerating An Effect
More Keyframing Tips
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Keyframing

Common Completion Adjustments

In the example below, two middle keyframes have been added at 20% and 80% Completion.

To increase the speed of part of the effect, drag one or more Completion keyframes to steepen the line's slope. In the example below, the middle portion of the effect now
progresses faster by dragging the 80% keyframe higher.

To decrease speed, reduce the keyframe line's slope. In the example below, the middle portion of the effect now progresses slower by dragging the 80% keyframe lower.

To hold/freeze the effect's progress, horizontally flatten all or part of the Completion line, as shown below. This profile is terrific to move into a PIP (picture−in−picture)
effect, hold it, then transition out.

To repeatedly pulse the effect, create a "spiked" Completion line, as shown below.
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To instantly reverse the effect's action/direction, click the Invert button located next to the spice image (circled below). This is usually quicker than manually reversing
keyframe values, especially if many keyframes have been set.

To reverse the clip order of a SpiceMASTER transition (this is different than reversing the effect's action/direction), use the transition controls in your timeline. For
the SpiceMASTER effect, click the Invert button (see above), then click the Completion Presets button and choose the 100% to 0% preset, as shown below.

Introduction
How to Add/Delete a Completion Keyframe

> Common Completion Adjustments
Keyframing Other Controls
How to Move a Keyframe Precisely
Navigating in the Keyframe Graph
Accelerating or Decelerating An Effect
More Keyframing Tips
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Keyframing

Keyframing Other Controls

Smoothly varying the value of a different SpiceMASTER control than Completion is nearly as easy. The main difference is you first must turn on the control's keyframing
(see below) so its graph will appear in the Keyframes area. To turn on keyframing for a control, click the round "light" that is left of the control you want to keyframe.
The light will turn bright green to indicate it is active.

Then the control's graph will appear in the Keyframes area −− initially as a horizontal line to show (so far) a constant value.

How to Add/Delete a Keyframe

Do either of the following steps: Click on the graph line to create a new keyframe. Then drag the keyframe to a desired position. As you drag the keyframe, its coordinates
will appear in the top left corner of the graph, and the preview will instantly update.

OR, drag the blue vertical playback marker near where you want the new keyframe, as shown by the preview. Then adjust the slider (or other control) for the setting
(Step 2 shown below). The graph will automatically add a keyframe at the new value. The control's keyframe light will now appear bright blue at that frame.

Note that instead of adjusting the slider to create a new keyframe, you could click the Add Key button above the Keyframes graph and then drag the new keyframe up or
down to the desired value. (To constrain its movement horizontally or vertically, hold down the Shift key.)

To delete a keyframe, right−click it and choose Delete keyframe. Or click the keyframe if it is not already active (it will appear brighter if active), then click the Delete Key (−)
button above the Keyframes graph. Note: If you recently added the keyframe, you could instead use Undo to revert to before that step. To delete ALL new keyframes for a
control and revert to the setting's default, right−click in the keyframe graph background and choose Revert to default. Or right−click the control's keyframe light.
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Keyframing

How to Move a Keyframe Precisely

Although dragging a keyframe in the Keyframes graph is the easiest way to position it, sometimes you may want more precision. To move a keyframe only horizontally or
vertically in the Keyframes graph, Shift−drag. To fine−tune the position, click the Zoom (+) button (shown below) to zoom into the graph and then drag as needed. (For
more zoom techniques, click here.)

To precisely position an existing keyframe, right−click the keyframe and choose Enter coordinates. Then enter the desired values as percentages (from 0% to 100%), as
shown below. Note that the keyframe's Time position may not end up exactly as entered if there are not enough frames in the effect to precisely match the percentage.

To change a keyframe's value (vertical position in the graph), use either of the above techniques. Or, move the blue vertical playback marker over the keyframe. The
setting's keyframe light will then turn bright blue. Then adjust the slider (or other control) for that setting.

To give a keyframe the exact value (vertical in the graph) of another keyframe, right−click the keyframe that has the desired value, then choose Copy value. Then
right−click the other keyframe and choose Paste value.

Introduction
How to Add/Delete a Completion Keyframe
Common Completion Adjustments
Keyframing Other Controls
> How to Move a Keyframe Precisely
Navigating in the Keyframe Graph
Accelerating or Decelerating An Effect
More Keyframing Tips
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Keyframing

Navigating in the Keyframes Graph

To jump to a specific keyframe, you can just click on it. But among tightly clustered keyframes, sometimes that can be difficult. Also, sometimes you may want to activate a
keyframe without perhaps accidentally changing its position by clicking on it. Here is an alternative: To select the next or previous keyframe, or first or last keyframe,
click the corresponding button located above the Keyframes graph.

How to Zoom In/Out of the Keyframes Graph

Zooming the keyframe graph is handy to more precisely position a keyframe, or to have several keyframes very close together. To zoom IN…
…horizontally toward the graph's center, click the Zoom In (+) button at the top left of the graph. Repeat to zoom in further, if desired.

…horizontally toward either end of the graph, drag inward either end of the graph's horizontal scroll bar. Likewise, to zoom in vertically to magnify the graph's top or
bottom, drag inward either end of the vertical scroll bar.

…vertically only, Shift−click the Zoom In (+) button. Shift−click the Zoom Out (−) button to vertically zoom out.
…vertically to the range where keyframes exist, right−click the graph's gray background, then choose Fit graph to keyframes. This can help you to fine−tune values in
relatively flat keyframe profiles.
…wherever you define, Alt−drag in the graph to define where you want to zoom. Or Alt−click the Zoom In (+) button (or right−click the graph's gray background and choose
Drag to zoom in), then drag to define where you want to zoom.

To scroll horizontally or vertically from where you zoomed, drag the gray background of the graph, or drag the center of either keyframe scroll bar (or click their arrows).
To bring the blue vertical playback marker into the zoomed region of a graph, click in the numerical bar above the graph.

To zoom back OUT by 2X, click the Zoom Out (−) button. To instantly return the graph to the entire duration (0% to 100%), double−click the Zoom Out button.

Tips

• To jump to a different area of a zoomed graph, first double−click the Zoom Out (−) button to return to the graph's default (full) view. Then Alt−drag in the graph to define
where you want to jump to.• You can drag a keyframe horizontally beyond a zoomed graph area. Although the graph will not scroll horizontally as you drag, you can use the
coordinates reported in the top left corner of the graph to see your position. Or, use the graph's horizontal scroll bar to reveal the target area before dragging.
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Accelerating or Decelerating An Effect

Straight segments of a keyframe line represent a linear (constant) rate of change in an effect's value −− thus no acceleration or deceleration. To add smooth acceleration
or deceleration, curve the keyframe line −− which is very easy in SpiceMASTER. That is because each keyframe automatically comes with two bezier curve handles you
can drag as desired. (Start and End keyframes only have one handle, of course.)

How to Manually Accelerate/Decelerate a Keyframe

To accelerate a change in an effect's value, drag the keyframe's bezier handle to create an upward curved line, as shown below.

To decelerate a change in an effect's value, drag the keyframe's bezier handle to create an downward curved line.

How to Make Automatic Bezier Adjustments

SpiceMASTER's keyframer also includes several automatic bezier adjustments that you can apply to one keyframe or all keyframes in a graph. To modify one keyframe,
right−click the keyframe and choose Convert keyframe to. Then choose an options below.

Linear −− remove all curves in the keyframe

Smooth −− decelerate before & accelerate after

Bounce −− accelerate before & decelerate after (opposite of smooth)
Smooth In −− decelerate before

Smooth Out −− accelerate after

Bounce In −− accelerate before

Bounce Out −− decelerate after

To modify ALL keyframes in a graph, right−click in the keyframe graph's gray background and choose Convert all keyframes to. Then choose any option shown above.

Tip

• To freely experiment with keyframes and revert to an earlier keyframe profile if necessary, use the Undo/Redo buttons in SpiceMASTER. SpiceMASTER has 100+
undo/redo's available so you can easily experiment with different settings. To undo a change, click the yellow Undo button (or tap  Ctrl−Z keys). To redo the change, click
the adjacent green Redo button (or tap Ctrl−X keys). If either is not available, the button will be dim.
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Keyframing

More Keyframing Tips

Below are additional handy tips that will enhance your keyframing in SpiceMASTER.

• Understanding keyframe "lights"
• More ways to switch to a different keyframe graph
• How to customize the Keyframes graph display
• How to flip/invert, scale, shift, or copy/paste an entire keyframe line
• How to manually adjust an effect's start/end point
• How to delay the start of an effect (or advance the end of an effect)
• How to move a bezier handle that is on top of a keyframe
• How to stay at a frame while adjusting keyframes elsewhere
• How to snap a keyframe to the vertical playback marker position

• Understanding keyframe "lights"

 DULL green is the default and means keyframing in OFF
for this control.

BRIGHT green means keyframing is ON for this control
(thus this control's graph will appear in the Keyframes
area), but NO keyframe is set at the current frame.

When you can add a keyframe, the bright green light will
turn bright blue. You can then adjust this keyframe's
value by dragging the slider or other methods.

DULL blue means there IS a keyframe for this control at
the current frame, but another control's keyframing is
ON. This is useful to know when you want to sync a
keyframe between two controls.

• More ways to switch to a different keyframe graph
To switch to a particular control's graph, such as when keyframing several controls at once, click the control's keyframe light. To toggle back to the effect's Completion
graph, click the light again −− or click the copper−colored Keyframes label area above the graph. To switch to ANY keyframe graph, Alt−click the Keyframes label area and
then choose the desired control (as shown below).

• How to customize the Keyframes graph display
Two adjustments are possible. You can hide/show grid lines in the graph (for a cleaner background), and you can hide/show the scroll bars for the graph (to slightly enlarge
the graph area). To access either option, right−click the graph's gray background and choose Show grid or Show scroll bars. Any change will be remembered automatically the
next time you apply SpiceMASTER.

• How to flip/invert, scale, shift, or copy/paste an entire keyframe line
Sometimes you may need to invert or flip a keyframe line, Or scale its peaks larger or smaller, or shift its timing ahead or back, or copy/paste a keyframe line to match the
keyframing in two or more controls. Instead of manually doing that, which could take considerable time, SpiceMASTER offers shortcuts. Just right−click the Keyframes graph
background (not on a keyframe line) and choose Adjust Keyframe Line > Flip Horizontally (or Flip Vertically, Invert, Scale/Move, Copy, or Paste).

• How to manually adjust an effect's start/end point
Occasionally you may need to manually adjust the Start or End keyframe of a SpiceMASTER effect, such as with rotated spice effects. Due to rotation (which increases the
scale of the spice image) the iris−like fog effect below, for example, visually ends at approximately the 85% frame instead of at 100%.
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Turning on SpiceMASTER's Auto−Adjust button often can solve such problems.

However, some situations may still call for manual adjustment of the effect's start/end timing. To do that, first right−click in the graph's gray background and deselect Sync
preview. Then move the blue vertical playback marker to just before the End keyframe (or just after the Start keyframe) Now drag the End (or Start) keyframe down (or up)

while watching the preview to see when the visual end (or beginning) occurs. By setting the last keyframe to 85% in this example, as shown below, this rotated fog effect will
visually end at the effect's true end in the timeline.

• How to delay the start of an effect (or advance the end of an effect)
A SpiceMASTER transition's duration is set in your video editing software's timeline, usually by adjusting the length of the transition's icon. Likewise, a SpiceMASTER effect (if
available for your video editing software) automatically takes on the entire duration of the clip it is applied to. However, sometimes you may want a SpiceMASTER effect to
appear only during part of the clip, by delaying the start of the effect or advancing the effect's end. To do that, choose the preset below from the Completion Presets palette,
then manually adjust the inner keyframes as desired.

• How to move a bezier handle that is on top of a keyframe
If you happen to drag a bezier handle directly on top of a keyframe, later dragging may move both points. To move only the bezier handle, first click the keyframe that
"owns" that handle −− to activate it. Then Ctrl−drag the bezier handle where desired.

• How to stay at a frame while adjusting keyframes elsewhere
SpiceMASTER's default behavior is to show the image that corresponds to wherever you drag or adjust a keyframe in the graph. The blue vertical playback marker therefore
follows your movement in the graph. Sometimes, however, you may want to keep viewing a particular frame while adjusting a keyframe elsewhere. Perhaps you want to
adjust a bezier curve while seeing how it alters an earlier or later frame's look. To do that, right−click in the graph's gray background and deselect Sync preview.

• How to snap a keyframe to the vertical playback marker position
When Sync preview is off (see above), sometimes you may need to move a keyframe to the blue vertical playback marker position, such as when aligning a keyframe in one
graph to a keyframe in another graph. To do that, position the playback marker where desired, then right−click the keyframe you want to move and choose Snap to Time.
The keyframe will then move to the frame the playback marker is on. If that position is not possible because it is beyond an adjacent keyframe, the command will not be
available.

Introduction

How to Add/Delete a Completion Keyframe
Common Completion Adjustments
Keyframing Other Controls
How to Move a Keyframe Precisely
Navigating in the Keyframe Graph
Accelerating or Decelerating An Effect

> More Keyframing Tips

Go to the next section of this Guide
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Cool Tips

Working in the Library

Choosing a "spice" file is a key step to applying SpiceMASTER. That's because your effect's design will be based on the spice file's design. With hundreds of available
spices, choosing could be a tedious process. Fortunately, SpiceMASTER includes a visual, interactive Library Ð a great tool to compare and select the best spice for your
desired effect. The Library shows spices as small side−by−side thumbnail animations −− much better than trying to choose from a long list of file names or icons!

The essentials of how to choose a spice file are covered in the earlier Basic Steps: 2. Choose a Spice File section. This page supplements that section by showing how you
can customize the Library and use its powerful management features. For example, you can create virtual folders of favorite (or project specific) spices. Spice file names can
be color−coded for later reference or to help you mark and narrow choices. Also, you can adjust viewing options to tailor the Library to your working style.

Customizing the Library Display
Organizing Existing Effects in the Library
Adding/Deleting Effects in the Library
Other Library Features

Customizing the Library Display

With just a few clicks, you can change the Library's thumbnail style, softness, play direction, and size. To customize the Library display to your working style, click its
Toolbar buttons. Equivalent commands are also in the Library menu.

a. Play/Stop Preview −− Play or stop the thumbnail animations. Stopping will reveal the grayscale design that is the basis for each effect's geometry.
b. Preview Speed −− Speed or slow the animation.
c. Reverse Preview −− Play forward only or reverse loop.
d. Preview Softness −− Play with or without edge softness.
e. Change Preview Size −− Increase or decrease the thumbnail size.

Keep in mind you also can adjust the size and location of the Library window (and drag between its two panes to adjust their width). You also can minimize the Library
window.

Tips

• To play only one spice animation in the Library while others do NOT play, click the Play/Stop toolbar button (button a above) to stop the animation of all effects. Then
right−click a thumbnail and choose Animate. Repeat as often as desired, such as when you have narrowed your choice to two or three spice candidates.

• To color a thumbnail name as a way to mark possible effects (such as favorites, or potential choices for an effect), right−click the thumbnail and choose a color. The
color will be stay on the thumbnail until you right−click and choose Black.

• To hide part of the Library to have more space for thumbnails, you can uncheck the status bar, toolbar, or left pane in the Options menu of the Library. Also, you can
toggle the window's tiling under the main SpiceMASTER dialog with the Tile Library Window command.

Organizing Existing Effects in the Library

You can create "virtual folders" to further organize Library effects into any group, such as spices for a particular project or type of production. Virtual folders only exist within

SpiceMASTER. Create as many as you want, with no penalty in disk space or speed. A Favorites virtual folder is already created for you, ready made to accept spices
from anywhere else in the Library. To create another virtual folder, click the blue Add Virtual Folder button (shown below) in the Library toolbar (or choose Edit > Add
Virtual Folder).

Then enter the desired name of the folder in the small dialog box that will appear. The new virtual folder will appear at the top of the Library's left pane. To later change the
name of the virtual folder, right−click the virtual folder and choose Rename Folder.
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To add an existing Library effect to the Favorites folder (or your virtual folder), display the effect in the Library's right pane, then drag and drop its thumbnail into the
Favorites folder (or your virtual folder) in the Library's left pane. A duplicate will then reside there (no additional disk space required).

Tips

• To create a subfolder within a virtual folder, right−click the blue virtual folder in the left pane and choose Add SubFolder.

• To delete an unwanted spice or folder, right−click any thumbnail (or folder) in the Library, then choose Delete Icon (or Delete Folder). Or select a folder in the left pane
and choose Edit > Delete Selected Folder. Either way, a warning dialog box that will appear to confirm your choice.

• To refresh/update a Library folder's contents after adding more effect files to that folder on your drive, right−click the folder in the Library's left pane, then choose
Refresh Folder. Note: If you accidentally delete a spice or spice subfolder from the Library, this technique on the main folder will quickly restore it.

Adding/Deleting Effects in the Library

The Library holds several hundred spices that ship with SpiceMASTER, a range wide enough to cover most effect designs you will ever need. However, the Library is
open−ended so you can add gradient/alpha wipes or custom mattes that you have created (or have acquired elsewhere). You can add an entire folder of those files or
individually add such effects to the Library. For more info about custom files, click here.

An existing Your Custom Files folder is already visible in the Library, which is handy for adding to the Library. That folder is located on your drive within the
SpiceMASTER 2.5\Spices folder in your editing software folder. Simply place a new gradient/alpha wipe file or custom matte file in that folder and it will automatically appear
the next time you open the Library.

To add an individual effect to a different Library folder than the Your Custom Files folder, first create a virtual folder in the Library (unless you want to add it to the
existing Favorites virtual folder). Then right−click the virtual folder and choose Add Spice. (Or with that folder selected, click the Add Spice button in the toolbar, or choose
File > Add Spice.) In the Open dialog that will appear, navigate to and select the desired file.

To add an entire folder of additional effects to the Library, click the yellow Add Source Folder button (shown below) in the Library's toolbar (or choose Edit > Add Source
Folder). This can be handy if you have a entire set of alpha wipes from another product that you wish to have available in the Library.

In the dialog that will appear, double−click the drive that holds the additional folder of effects. Navigate until you can select that additional folder of effects, then click OK. The
selected folder will then appear in the Library's left pane, like any spice folder.

To delete an effect or folder, right−click any thumbnail (or folder) in the Library, then choose Delete Icon (or Delete Folder). Or select a folder in the left pane and choose
Edit > Delete Selected Folder.

Other Library Features

Tiling the Library
By default, with sufficient screen space the Library will open directly below the main SpiceMASTER dialog (thus "tiled"). It's a great convenience to have both windows open,
SINGLE−clicking on spice thumbnails to compare the effects real−time in SpiceMASTER's preview with particular settings. On smaller screens, however, the tiled position
may not show all spices in a folder (without you having to scroll the window). To see more Library thumbnails at once, uncheck Options > Tile Library Window. The Library
window will toggle between normal and tiled positions.

File paths
Need to know the file path of a particular choice in the Library? Select the item in the right pane, then look in the Status Bar along the bottom of the Library window.

next page
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Saving Favorite Effects

SpiceMASTER includes a HUGE number of saved settings to instantly create a wide range of transitions and effects. You can also save your own custom effects. Favorite
effects, or even just certain settings or keyframes, can be instantly reapplied, saving you time. Also, SpiceMASTER's 100+ undo/redo capability can temporarily retain
settings so you can experiment further before applying an effect.

SpiceMASTER has two ways to apply previously created effects −− section presets and saved settings. Each offers different advantages to you: Section presets are
accessed by a "light bulb" button atop certain control sections −− they only affect controls in that section. Saved settings, unlike section presets, typically affect ALL controls
in SpiceMASTER.

How to Apply a Section Preset

Click a light bulb at the upper right corner of a section, then choose a preset from the submenu. Trying presets is a quick and easy way to overview a section's effects
capabilities. Keep in mind you can do this while the SpiceMASTER preview plays.

How to Apply a Saved Setting

1. Click the blue Load Saved Settings button in the black bar, as shown below. An Open dialog will appear to choose the desired saved settings file. (If the
SpiceMASTER 2.5\Saved Settings folder is not open, navigate to it.)

2. Several subfolders of saved settings, organized by style, will appear in the Open dialog. Go into any subfolder and click a save settings file. The settings will
preview in the Animate box within the dialog, making it easy to choose a desired file.

How to Create a New Saved Setting

1. Click the blue "+" Save Current Settings button in the bottom black bar of SpiceMASTER. A Save As dialog will appear.

2. Name the file (be descriptive) and click the Save button.

Tips

• To save settings that (when loaded) will NOT change the current spice file, turn OFF the Include Spice check box in the Save As dialog box when you create the
saved setting.

• To have a saved setting NOT change other effect settings when loaded into SpiceMASTER, before double−clicking the desired file, turn ON the Choose Settings
check box in the Open dialog. In the Import/Export Settings dialog that will appear, use the OFF buttons to protect one or more sections of existing settings you want to
keep.

• To undo any saved setting or section preset choice, click the Undo button at the top right of the effect's window. The effect's 100+ undo/redo capability can temporarily
retain settings so you can easily experiment!

• To select from most recently used saved settings, Ctrl−click the blue Load Saved Settings button.

• Saved settings can be transferred to other editing stations with SpiceMASTER 2.5. Just put the saved settings file you created in the other station's SpiceMASTER
2.5/Saved Settings folder.

• If you have a cool saved setting that you'd like to share with all other users, please email attach it to support2@pixelan.com, include your full contact info, and we will
evaluate it for our web site, with you credited if it is posted.

next page
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Cool Tips

Changing the Default Settings

The new default will determine the spice file and settings that will appear initially the NEXT time you apply SpiceMASTER. Changing the default is quick and easy:

1. Apply SpiceMASTER in your timeline so that its main dialog appears.

2. Choose a desired spice file and adjust effect controls as desired.

3. Click the Prefs tab to view the Preference pane, then click the Set button at the bottom of the pane.

To revert to SpiceMASTER's "Factory" default, do either of the following steps:

• Click the Prefs tab to view SpiceMASTER's Preference pane, then click the Clear button at the bottom of the pane. Clear will NOT change the current effect −− the new
default will appear the NEXT time you apply SpiceMASTER. Note: Clear will not change SpiceMASTER's preferences, which are retained automatically when changed.

• To do the above AND clear the current effect's spice and settings to the "factory" default, Alt−click the yellow Clear Settings (−) button in SpiceMASTER's black bar
area.

Go to the next Help section
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Cool Tips

Preferences

SpiceMASTER's preferences are centralized in the Prefs pane. All options there are global −− SpiceMASTER will remember them from effect to effect.

Built−in Preview

SpiceMASTER's built−in preview usually can maintain a real−time pace even on older/slower computers. If the preview appears choppy, however, SpiceMASTER includes a
few ways to speed processing up. Choose an option below in the Prefs pane, or trigger the option temporarily by using the keyboard shortcuts shown:

• No image update (Shift−click the Play button) not in Vegas version
Preview will play only with a single frame shown from the source clip(s). AVID users: This is your default, due to Avid AVX plug−in constraints. To play ALL frames of video
content when previewing, turn OFF this option −− temporarily by Ctrl−clicking the Play button, or permanently by turning off this option in the Prefs pane.

• No UI update (Alt−click the Play button)
Preview will play, but SpiceMASTER's interface (controls, keyframe graph, etc.) will not update during playback.

• Drop frames if necessary (Ctrl−click the Play button)
SpiceMASTER will drop frames if necessary to keep the pacing correct. Turn it OFF to ensure you will preview every frame of the effect (even if the pacing is longer).

Output

Fields  (not in Vegas version)
Almost all SpiceMASTER users should stick with the Use NLE settings default. SpiceMASTER will then use the same field order as your video editing software. However, if
in your final output you see "raggedness" along a SpiceMASTER effect edge or where other motion occurs, then choose Reverse order AND turn on the Full vertical
resolution option below (if available).

Full vertical resolution
Only in certain versions of SpiceMASTER, such as for Premiere. Increases vertical resolution of effects, instead of the field doubling Premiere does by default.

Subpixel PIP precision
High−contrast imagery or slow motion in PIPs (picture−in−picture effects) can show some blurriness with subpixel positioning. Turn this option off if you see that problem.

Adjust shadows for transparency
When a SpiceMASTER effect is applied softly to a shadowed title, with certain settings the title's shadow may appear too visible under the title characters along the
SpiceMASTER effect's edge. In that case, turn on this option.

Safe color selection
While on, selected Border and Shadow/Glow colors will more likely be "safe" for broadcast −− not too saturated or pure white/black. (Awareness of the safe issue while
choosing colors is the best precaution, though.) It constrains RGB values to 16−235. For multimedia output, turn this option off to have the full color range available.

Widescreen (16:9) (DPS, Pinnacle, and Ulead versions only)
Turn on to manually set SpiceMASTER's built−in preview to a 16:9 aspect ratio −− in editing systems that cannot set this automatically. SpiceMASTER itself is resolution
independent −− this option only affects the preview.

General

Time Units  (not in Vegas version)
This option affects the display of the Current Frame and Duration indicators below SpiceMASTER's preview. Choose relative Timecode values or relative Frames.

Auto−open SpiceMASTER window (Vegas version only)
Turn this on to skip the initial video fx window for SpiceMASTER that appears in Vegas. Turn this off if incompatibility problems appear.

Auto−close (or Hide) Video Event FX window (Vegas version only)
Removes (or hides) the video event FX window after (while) SpiceMASTER is applied −− a convenience.

Show pop−up text  (not in Vegas version)
Shows a brief text description when the cursor is over certain SpiceMASTER interface areas. Turn it off if it seems like a nuisance.

Confirm clearing of keyframes
With this option on, when clearing keyframes SpiceMASTER will ask for confirmation −− a good safety net for most users.

Confirm before exiting w/o changes
Another safety net so you won't accidentally lose a cool effect you've set up in SpiceMASTER.

Make current FX settings the default
To set a new default effect, choose a desired spice file and adjust settings, then click the Set button. To clear SpiceMASTER default settings back to the "factory" default,
click the Clear button. That Clear button will NOT change the current effect's settings (see below). It will change what effect appears the NEXT time you apply
SpiceMASTER. Clear will not change other preference settings.

To clear the current effect's settings back to your default SpiceMASTER effect, but retain the chosen spice file and NOT leave SpiceMASTER, click the yellow Clear '−'
button in the black bar area of SpiceMASTER.)

next page
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More Cool Tips

Click below for additional creative capabilities you can achieve with SpiceMASTER.

• Bezier−Controlled Fades
• Beautiful Soft Slide/Zoom/Drop Effects
• Combined Spice Designs
• Easily Build Adjustable, Soft Mattes
• Easy Animation/Distortion/Texture Effects
• Brewing Your Own Effects for SpiceMASTER

Bezier−Controlled Fades

Most video editing software only provides linear fade−ins or fade−outs of clips. Often, however, it can be very useful to create a smoother changing or
accelerated/decelerate fade. With a simple trick, you can use SpiceMASTER's bezier curve keyframing to smoothly vary a clip's opacity. No spice effect will appear −− just a

terrifically smooth uniform fade that speeds up or slows down as it progresses. Several saved setting files are included for this type of effect. To apply one:

1. After applying SpiceMASTER, click the blue Load Saved Settings button, as shown below. An Open dialog will appear to choose the desired saved settings file. (If
the SpiceMASTER 2\Saved Settings folder is not open, navigate to it.)

2. Double−click the Bezier Fades subfolder and click any save setting file within it. That's all!

Beautiful Soft Slide/Zoom/Drop Effects

Unlike most NLEs, a bonus of using SpiceMASTER is you can have bezier curve−controlled super−softness or opacity in a slide, zoom or drop transition. This can
dramatically change the character of such 'standard' effects to something fresh, elegant and beautiful, as shown below.

View movie at our web site

Several saved settings are provided in SpiceMASTER to instantly create such effects! Just follow Step 1 above, then choose any saved setting file from the Soft Slides or
Soft Zooms folder. Note: If you prefer an organic zoom edge, instead of a super−soft look, apply one of the above saved settings, then reduce the Softness slider(s) and
experiment with the Texture > Amount slider (and possibly the Invert button). For an animated organic edge, also turn on the Texture > Motion slider.

Combined Spice Designs

SpiceMASTER's Library is loaded with hundreds of spice designs, covering most production situations. In addition, the Texture section of SpiceMASTER can add organic
edge qualities to even non−organic spices. And you can adjustably zoom any alpha channel graphic or black & white matte to create softenable spice−like effects with
custom geometries. With all of these capabilities, you'll likely always find a suitable design for your SpiceMASTER effect.

Last but not least, the powerful Mixer control blends any chosen spice design with the luminance of your clips, tailoring the effect even further to your content. However, you
have one more nifty way to create additional SpiceMASTER effect geometries: apply the SpiceMASTER effect (if available) more than once to the same clip to
combine spice designs.

In the example above, the SpiceMASTER effect was applied twice to the blue clip, to reveal the lower eye clip. All SpiceMASTER settings were identical both times
(OrganicFX\Climatics\Fog2 C spice plus some white border), but in one the effect was reversed (by clicking the Invert button in SpiceMASTER). Thus the combined effect

progresses organically in a new way.

Easily Build Adjustable, Soft Mattes

Most video editing programs can form simple garbage mattes, which can be useful to mask out unwanted areas of a clip, such as static along a frame edge, an unwanted
region of a scene, an area trailing a title, etc. Usually you cannot soften the garbage matte's edges and you are limited to straight−edged basic shapes (no curves or
unusual/organic shapes). Not anymore! By applying SpiceMASTER and 'freezing' the progress of a spice effect, you can easily apply softenable custom mattes for any
purpose. SpiceMASTER's Library includes lots of fundamental shapes to create mattes in virtually any geometry. All are adjustable for position, size, softness, etc. directly in
SpiceMASTER.
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The technique is easy: After applying a SpiceMASTER effect (if available) and selecting a spice file from the Library, choose the 'flat' Completion Preset (shown
below) in the Keyframes area and drag that keyframe line up or down in the Keyframes graph to set an iris−size or wipe−position as desired. To further fine−tune the matte's
position, drag the orange handle in the grayscale spice image. That's all!

If the spice effect does not exactly match the matte shape you need, try the Combined Spice Designs tip above to create a custom shape. To fine−tune the matte's
softness, apply Softness > All Edges. In addition to softness, most other SpiceMASTER enhancements in the Edge and Depth pane are available for the matte's edge −−
border, glow, shadow, etc. For example, if you apply Texture > Motion then you can animate the matte's edge during the effect −− cool!

Easy Animation/Distortion/Texture Effects

SpiceMASTER's numerous controls in the Edge and Depth panes are not only useful to enhance spice effects. They can be applied directly to a single clip to produce a

huge range of quick and easy animation, distortion, and texture effects for you! The technique is easy:

1. Synch two copies of the SAME clip in your timeline. One clip copy will therefore sit directly above the other copy.

2. Apply the SpiceMASTER transition between the clip copies (if they are in the same track). Or apply the SpiceMASTER effect (if available) to the TOP clip copy. If you
applied the SpiceMASTER effect, be sure to also activate the alpha channel key in the TOP clip, if required by your editing software.

3. Set up the effect. In the main area of SpiceMASTER, click the Choose Spice File button to select a spice with the effect design you desire.

4. Apply any enhancement from Border, Shadow/Glow, or Bevel/Ripple sections of the Edge and Depth panes of SpiceMASTER. Modify further if desired with the
Softness and Texture sections. Instant flowing energy wave!

Brewing Your Own Effects for SpiceMASTER

Despite the hundreds of spice files included with SpiceMASTER and the near−infinite ways to modify and customize them, occasionally you may still want to create your
own "spice". Perhaps you need an effect that has the exact shape as a client's logo or graphic, or some other custom need. Since SpiceMASTER is open−ended, it will
readily accept any still−image as a spice. The file should have a wide range of grayscales −− from pure black to pure white −− to create an effect that changes over time
(such as a transition). Or the file can be a simple black & white matte to load and enhance in SpiceMASTER.

To create such a custom file, use a graphics program such as Photoshop to (a) create the grayscale still−image at the same size as your final output (such as 720x480
pixels), and (b) save the file in any format below. Then load the file directly into SpiceMASTER, or add it the Library for repeated future use. SpiceMASTER can load files in
the following formats: BITMAP (.bmp or .dib), TIFF (.tif), PNG (.png), PICT (.pct), JPEG (.jpg), and TARGA (.tga).

Go to the next section of this Guide
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Advanced Techniques

Introduction

In this Advanced Techniques section, we assume you know how to apply SpiceMASTER to create fresh transitions, from super−soft and subtle directional dissolves to
organic/cutting−edge looks. (If not, please go to Basic Steps before proceeding.)

SpiceMASTER is more than a terrific tool to create fresh, fully−customizable organic transitions. It has several other useful capabilities which are covered in this
Advance Techniques section. Take some time to work through this section and you will become a true master of SpiceMASTER. Enjoy!

TUTORIAL: How to Animate Other Effects or Keys

TUTORIAL: How to Reveal Titles Organically or Softly
TUTORIAL: How to Create Directional Fades for Title Rolls & Crawls
TUTORIAL: How to Organically Animate Titles

TUTORIAL: How to Apply Organic or Soft PIPs

TUTORIAL: How to Enhance Black & White Mattes
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Advanced Techniques

TUTORIAL: How to Animate Other Effects or Keys

In addition to applying soft/organic custom transitions, SpiceMASTER can easily animate other video effects in a single clip. SpiceMASTER therefore leverages the
power of ALL visual effects (built−in or third−party) available in your video editing software. Organically flow a color change from a moving subject outward to the
frame edge (as shown below). Or softly wash a blur organically across the scene. Or accomplish any other animation you desire for an effect that would otherwise alter the
entire image.

More examples

SpiceMASTER also can softly or organically reveal/hide virtually any key in your editing software (such as a luminance, chroma, multiply, or screen key), adding
fresh dynamics that can create subtle, gorgeous, and unique key looks.

How to Animate Other Effects

1. Synch two copies of the SAME clip in your timeline. One clip copy will therefore sit directly above the other copy.

2. To ONE clip copy (not both), apply the visual effect(s) you want to animate. They can be built−in or third−party plug−in effects. In the example below, a simple color
change has been applied.

Original clip Clip with color filter
3. Apply the SpiceMASTER transition between the clip copies (if they are in the same track). Or apply the SpiceMASTER effect (if available) to the TOP clip copy (and
be sure to activate the clip's alpha channel key, if required by your editing software). Avid users: Just apply SpiceMASTER as a segment effect in the top clip.

In the SpiceMASTER dialog, the spice file you choose and its position will determine where the animated effect(s) will appear. Fine−tune further as desired, using
SpiceMASTER's Edge and Depth panes. In the example below, an OrganicFX\Burst spice animates the color change effect. Note the effect is positioned off−center with
SpiceMASTER to open over the eye.

You can also use the technique to animate different settings of the same visual effect. In Step 2 above, apply the same effect to BOTH clip copies, but with different settings.

How to Animate a Key (not available in Ulead MediaStudio version)

1. Synch two copies of the SAME clip in your timeline. One clip copy will therefore sit directly above the other copy. Both copies should sit in your timeline above the
content you will reveal with the key.

Clip to be keyed Background clip
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2. To the LOWER clip copy, activate the key you want to animate, such as a luminance, multiply, screen or chroma key. Any content passing 'through' the key will of
course then appear in the output.

3. To the TOP clip copy, activate the alpha channel key, if required by your editing software. Then apply the SpiceMASTER effect to the TOP clip copy. Avid note:
Just apply SpiceMASTER as a segment effect in the top clip.

In the SpiceMASTER dialog, the spice file you choose and its position will determine where the key will appear within the image. Fine−tune further as desired, using
SpiceMASTER's Edge and Depth panes.

Clips in timeline Screen key revealing the clouds is softly animated outward

Tips for Either Technique

• Clip copies can be trimmed differently IF they remain in synch. If you applied the SpiceMASTER transition, the FIRST clip can optionally be trimmed to start and/or
end earlier than the other clip, as shown below (left). If you applied the SpiceMASTER effect, the TOP clip can be trimmed to start later and/or end earlier than the other clip
(see below right).

Trimming: SpiceMASTER transition Trimming: SpiceMASTER effect (top clip)

• If you applied the SpiceMASTER effect, SpiceMASTER's preview will not show lower clips. Instead, a simple grid background will appear. To switch to a black, gray,
or white background, right−click the preview and choose Background. To see the entire image, preview from your timeline.

• Prefer a fixed (non−changing) matte for an effect or key? Simply 'freeze' the SpiceMASTER effect by selecting the "flat" preset from the Completion Presets palette in
the top right corner of the Keyframes area. Then drag the flat keyframe line up or down as desired to set the 'freeze' point.

next page
Advanced Techniques main page
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Advanced Techniques

How to Animate Other Effects or Keys −− Examples

Organically or softly animating other visual effects or keys is very useful creatively for a wide range of productions. Below are a few examples easily achieved in
SpiceMASTER.

View movie at our web site
Organically introduce an effect on your subject, flowing the effect to the frame edge. In SpiceMASTER, you can easily drag to position where the effect will appear (in this
example, opening over the head).

View movie at our web site
Another example of an organic, soft color change.

View movie at our web site
Easily keyframe the effect's position over time to follow your moving subject.

View movie at our web site
Softly open and close effects timed with your action. In the above example, a blur and color change strengthen over the eye and then disappear with the blink, using
SpiceMASTER's bezier keyframing of Completion.

View movie at our web site
Enhance an effect animation with a glow along its edge as it opens. Or apply a shadow, texture, border or other edge enhancements.

View movie at our web site
Use SpiceMASTER to dramatize the center of action by softly animating where subtle brightness changes occur.

View movie at our web site
Softly flow a screen key outward from the eye to progressively reveal more of the lower clip −− a sunset.
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View movie at our web site
Timed with the subject's arm action, SpiceMASTER introduces from the top corner a chroma key of the sky's blue to reveal the lower clip −− an abstract, blue streaky
background.

View movie at our web site
The statue's luster is revealed by organically removing a chroma key that filled the statue with the dark gold solid color of a lower clip. Electricity is applied via
SpiceMASTER's border controls.

View movie at our web site
A luminance key through a cloud clip semi−transparently shows the eye clip −− SpiceMASTER then organically strips the key away in a similar cloud−like fashion with a
softened OrganicFX\Climatics spice.

next page
Advanced Techniques main page
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Advanced Techniques

TUTORIAL: How to Reveal Titles Organically or Softly

SpiceMASTER powerfully supplements your video editing software's built−in titling and even the most sophisticated CG/title software. With a few clicks, SpiceMASTER
provides entirely new classes of compelling title effects and treatments that previously were very difficult or impossible. Use any of SpiceMASTER's hundreds of spice
designs to softly or organically reveal/erode titles, logos/graphics and text backgrounds −− any clip with an alpha channel −− even if it is moving or has other effects applied.

More examples

How to Reveal Titles Organically or Softly

Note: If you use Avid or Ulead MediaStudio, the steps below do not apply. Click here for an alternative method.

1. Apply the SpiceMASTER effect (not transition) to a title clip in your timeline. (Click here if you do not know how to apply SpiceMASTER.) The title clip must have its
alpha channel key activated in your timeline.

2. Go to the PIP+ pane of SpiceMASTER. Choose Choose > Title/Alpha, as shown below. Note: If the title clip has a black background, instead choose Choose >
Title/Alpha on Black. If the title clip has a white background, choose Choose > Title/Alpha on White.

3. Set up the effect. In the main area of SpiceMASTER, click the Choose Spice File button to select a spice with the effect design you desire. Then adjust the effect using
controls in the Edge or Depth panes.

Tips

• To invert the title area altered by the effect, turn on the Invert Alpha check box in the PIP+ pane.

Title 'dripped' on Invert Alpha on

• To reverse the direction of an iris−like effect, click the Invert button next to the spice image. (Or press the Alt−9 keys.) The spice's graycales will invert to reverse the
effect's action.

• To start (or end) the title's reveal exactly at the beginning (or end) of the clip, in SpiceMASTER's Keyframes area right−click in the graph's gray background and
deselect Sync preview. Then move the blue vertical playback marker to just before the last keyframe (or just after the first keyframe) Now drag the last keyframe down, as
shown below, (or first one up) while watching the preview to see when the visual end (or beginning) occurs.
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• Most video editing software can set the transparency of a title −− uniformly. Some CG programs also can vary transparency linearly in one direction, such as left to right.
But SpiceMASTER can go much further, applying variable, organic transparency (stationary or animated) for a more sophisticated or realistic look.

To create a constant variable transparency in a title, follow the steps at the top of this page AND adjust one or both Softness sliders in SpiceMASTER to a high level.
Then choose the 'flat' Completion Preset (shown below) in the Keyframes area and drag that keyframe line up or down to set the transparency as desired. You also may
need to drag the orange handle in the grayscale spice image to reposition the effect.

next page
Advanced Techniques main page
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Advanced Techniques

TUTORIAL: How to Reveal Titles Organically or Softly

Steps for Avid Users

1. Apply the SpiceMASTER transition. Between a title in your Avid timeline and the filler, apply a SpiceMASTER transition. Adjust the transition's duration as desired. To
apply the transition as a segment effect, adjust the length of the transition to the entire length of the title.

Steps for Ulead MediaStudio Users

1. Render the title movie. In an unused region of your timeline, overlay your title clip over a copy of the intended background clip. Then render the title output, using a
high−quality or lossless video codec (such as "None" at Millions+ color depth).

2. Import the rendered clip into the timeline within your project. Overlap the rendered clip over the same background clip as before, but this time in your production, not
an unused area of the timeline. The background in the rendered clip should therefore appear identical and in synch with the background clip.

3. Apply the SpiceMASTER transition between the rendered clip and background clip. In the main area of SpiceMASTER, click the Choose Spice File button to select a
spice with the effect design you desire. Then fine−tune further as desired, using SpiceMASTER's Edge and Depth controls.

Tips (Avid or Ulead version)

• To reverse the direction of an iris−like effect, click the Invert button next to the spice image.

• To start (or end) the title's reveal exactly at the beginning (or end) of the clip, in SpiceMASTER's Keyframes area right−click in the graph's gray background and
deselect Sync preview. Then move the blue vertical playback marker to just before the last keyframe (or just after the first keyframe) Now drag the last keyframe down, as
shown below, (or first one up) while watching the preview to see when the visual end (or beginning) occurs.

• Most video editing software can set the transparency of a title −− uniformly. Some CG programs also can vary transparency linearly in one direction, such as left to right.
But SpiceMASTER can go much further, applying variable, organic transparency (stationary or animated) for a more sophisticated or realistic look.

To create a constant variable transparency in a title, follow the steps at the top of this page AND adjust one or both Softness sliders in SpiceMASTER to a high level.
Then choose the 'flat' Completion Preset in the Keyframes area (shown below) and drag that keyframe line up or down to set the transparency as desired. You also may
need to drag the orange handle in the grayscale spice image to reposition the effect.

next page
Advanced Techniques main page
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Advanced Techniques

How to Reveal Titles Organically or Softly −− Examples

Directional Dissolves. A subtle, beautiful alternative to standard uniform dissolves of titles. Even if you are a pure "cuts and dissolves" editor, SpiceMASTER's ultra−soft
'directional dissolves' can be a compelling alternative to standard dissolves/fades, adding a subtle hint of movement or geometry to lead the viewer's eye in a title or graphic.

View movie at our web site
A softly curved, left−to−right directional dissolve reveals the text, which also has a soft bevel and glow applied with SpiceMASTER.

View movie at our web site
The Power title fades in very softly and organically outward as the title zooms in over the red color change also controlled by SpiceMASTER. Notice how SpiceMASTER
allows the effect to be off−center to match the background.

View movie at our web site
The Attitude statement is softly revealed and then faded as it moves near the frame edge.

Organic reveals. Reveal titles with a flowing, organic, natural−looking edge −− a fresh approach compared to the straight−line, hard−edged wipes of titles common in CG
programs.

View movie at our web site
The spice OrganicFX\Fluids\Drippy3 V is applied with only slight softness (to preserve the effect's edge detail). The border and glow in the semitransparent title are also
from SpiceMASTER.

View movie at our web site
Three more examples of organic reveals of text accomplished easily with SpiceMASTER.

Flowing cutouts. Organically reveal title/logo cutouts in hundreds of creative ways with SpiceMASTER.

View movie at our web site
The organic white border and logo border are both applied via SpiceMASTER.
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Trailing backgrounds. Use SpiceMASTER to organically trail solids (or video, as shown below) behind titles.

View movie at our web site
Note how the trailing edge fits the rough organic texture of the water. SpiceMASTER's Texture controls were applied to a simple PureFX spice.Fresh logo dynamics.
Reveal logos using soft or organic geometries that tie into the logo shape.

View movie at our web site
The logo is revealed progressively from its center. The bevel in the logo was also applied by SpiceMASTER.

next page
Advanced Techniques main page
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Advanced Techniques

TUTORIAL: How to Create Directional Fades for Title Rolls & Crawls

Fade titles seamlessly as they enter or leave the frame (or any other area, such as near a graphic or PIP) to add a terrific but subtle touch to credit rolls and text crawls.
SpiceMASTER does this flexibly and quickly compared to manually creating fixed, nonadjustable mattes.

View movie at our web site

Steps

1. "Sandwich" the title clip. Overlay your title clip above a background clip in your timeline. Next, above BOTH clips, synch a copy of the SAME background clip that is in
the bottom track. (In most systems, this means all three clips will be directly above each other −− see image below.) Avid users: Instead of the above, just apply
SpiceMASTER between a title in your Avid timeline and the filler. Adjust SpiceMASTER's duration as desired. Then go to Step 4 below.

2. Put the title in motion. Use your NLE's or CG program's motion capabilities to roll or crawl the title clip as desired.

3. Apply the SpiceMASTER effect to the TOP background clip. (Click here if you do not know how to apply it in your NLE.) Be sure to also activate the alpha channel key
in the TOP clip. How to do this depends on your editing software.

4. Set up the effect. In the main area of SpiceMASTER, click the Choose Spice File button to select a spice with the effect geometry you desire. To feather the frame edge,
for example, choose SPices/Irises1/Frame C in the Library. Be sure to also apply some Softness.

5. Set the edge feathering. Click the 'flat' horizontal Completion preset (shown below). Then, in the Keyframes graph, drag the flat keyframe line up or down from 50% to
set the feathering depth.

Tips

• This technique also works for seamlessly fading other moving content besides titles, such as PIPs (picture−in−picture effects).

next page
Advanced Techniques main page
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Advanced Techniques

TUTORIAL: How to Organically Animate Titles

Most video editing software can "punch out" titles to show lower content, but only SpiceMASTER can easily blend and animate content, colors, highlights, etc. within titles as
desired. In fact, you can use SpiceMASTER to easily animate virtually ANY video effect (built−in or third party) in your system that is applied to a title. SpiceMASTER also
provides unique organic effects of its own that are terrific for titles. The effects can be pulsed, flowed, intensified, etc. over time with bezier keyframe control. No longer are
you limited to a few tired "stock" effects of a "high−end" CG program.

View movie at our web site

Steps

1. Synch two copies of the SAME title clip in adjacent tracks of your timeline. (In most systems, this means one clip copy will be directly above the other copy.)
Additionally, you may have background clip(s) under both title clips. Avid users: Instead of the above, just apply SpiceMASTER between a title in your Avid timeline and the
filler. Adjust SpiceMASTER's duration as desired. Then go to Step 5 below.

2. To ONE title clip copy (not both), create the different look you want to animate/flow, such as a different color, highlighting, or applied effects (built−in or third−party).

3. Apply the SpiceMASTER effect to the TOP title clip in your timeline. (Click here if you do not know how to apply it in your NLE.) Be sure to also activate the alpha
channel key in the TOP clip, if required by your editing software.

4. Go to the PIP+ pane of SpiceMASTER. Choose Choose > Title/Alpha. Note: If the title clip has a black background, instead choose Choose > Title/Alpha on Black. If
the title clip has a white background, choose Choose > Title/Alpha on White.

5. Set up the effect. In the main area of SpiceMASTER, click the Choose Spice File button to select a spice design. Then adjust the effect using controls in the Edge or
Depth panes.

Tips

• To reverse the direction of an iris−like effect, click the Invert button next to the spice image.

• To start (or end) the title's animation exactly at the beginning (or end) of the clip, in SpiceMASTER's Keyframes area right−click in the graph's gray background and
deselect Sync preview. Then move the blue vertical preview marker to just before the last keyframe (or just after the first keyframe) Now drag the last (or first) keyframe
down (or up) while watching the preview to see when the visual end (or beginning) occurs.

• To invert the title area altered by the effect, turn on the Invert Alpha check box in the PIP+ pane of the SpiceMASTER effect.
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Advanced Techniques

How to Organically Animate Titles −− Examples

View movie at our web site
The title's blue color and white border organically erodes from left to right as the title scales larger. All aspects of this effect were accomplished with SpiceMASTER.

View movie at our web site
As the Saturday Night text zooms larger, a multicolor noise filter controlled by SpiceMASTER animates outward within the text.

View movie at our web site
In the Revealing title of this trio, SpiceMASTER adds a light sheen and border edge after organically revealing the title.

View movie at our web site
The D1 title clip did not have such a border originally, but SpiceMASTER added that enhancement in addition to organically "dripping" the title onto the background.

next page
Advanced Techniques main page
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Advanced Techniques

TUTORIAL: How to Apply Organic or Soft PIPs

SpiceMASTER revolutionizes the creative possibilities with PIP (picture−in−picture) compositions. No longer must they be limited to hard, straight−edged looks. With
SpiceMASTER, you can easily apply a soft or organic edge between such images. The PIP edges even can be animated for entirely new looks! And PIPs can be entirely

new shapes −− from geometric to organic. Then easily apply softness, animated edge texture, dynamic borders, shadows, glows, or bevels. Virtually all effect
enhancements in SpiceMASTER are available for PIPs, giving you a huge range of fresh looks that previously were unavailable.

More examples

With SpiceMASTER's bezier keyframing, PIPs can smoothly accelerate/decelerate in motion or scale. And you can easily fly−in/hold/fly−out any PIP or organically
reveal/hold/hide it.

Steps

1. Apply the SpiceMASTER transition between the clip (that will become the PIP) and an overlapping background clip, as shown below left. Or apply the SpiceMASTER
effect (if available) to the PIP clip, as shown below right. (Click here if you do not know how to apply SpiceMASTER.) If you applied the SpiceMASTER effect, be sure to
also activate the alpha channel key in the PIP clip, if required by your editing software. Avid users: Instead of the above, just apply SpiceMASTER as a segment effect in
the top clip over the overlapping background clip.

2. Click the blue Load Saved Settings button in the black bar of SpiceMASTER. To use or modify an pre−made PIP effect, choose any saved setting in the PIP+ or
Animated PIPs folder within the Saved Settings folder. To build a PIP effect from scratch, choose the Basic Setup −− PIP file from the Saved Settings folder.

3. Choose an iris−like spice. In the main area of SpiceMASTER, click the Choose Spice File button to select an iris−like spice with the shape you desire for the PIP.

Iris−like spice files are in any of the following folders of the Library: OrganicFX\Bursts, OrganicFX\HotIrises, OrganicFX\Plasmas, or Spices\Irises. Shown below is
OrganicFX\HotIrises\Slatta2.

4. Adjust the iris opening size by moving the flat keyframe line for Completion up or down in the Keyframes graph, as shown below.

5. Customize the PIP's edge, using any of the controls in the Edge or Depth panes. To soften the PIP edge, for example, use the Softness sliders. To animate the PIP
edge, use the Texture section and activate its Motion slider. Dynamic borders, shadows/glows and bevels are also available for PIPs −− try the various presets provided in
the "light bulb" at the right top edge of each effect section. In the example below, an aqua glow plus extensive All Edges softness surround the organic PIP edge.
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More examples

You are done unless you want to customize the PIP further, such as to position it, put it in motion, change its opacity, etc. as described below.

How to Enhance the PIP

• To reposition or scale the PIP, drag the center dot (as shown below) or surrounding frame outline of the PIP in the SpiceMASTER preview −− or adjust the Matte sliders
in the PIP+ pane.

• To reposition or scale the image within the PIP opening, select Choose > PIP (Move Within) at the top of the PIP+ pane, then drag the center dot or surrounding frame
outline in the SpiceMASTER preview (or adjust the Image sliders in the PIP+ pane). This can be very handy to keep a moving subject within the visible PIP area.

• To change the opacity of the PIP, drag the Opacity slider in the PIP+ pane as desired.

• To keyframe any of the above adjustments, such as to put the PIP in motion, first turn on (click) the round keyframe light at the left of the relevant control (such as
Matte > X). The keyframe light will be bright and the Keyframes graph for that control will appear. Drag the blue vertical playback marker in the graph to the desired frame for
a keyframe, as shown below. Then do the desired adjustment for the control, such as setting the X to .5. Go to another frame (such as the last frame), then set different
values for the control. Repeat for as many keyframes as desired. For more about keyframing, click here.

• To try other common PIP moves, click the "light−bulb" at the right of the Matte section and choose a preset.

• To reveal, hold, then remove the PIP, click the "flat hill" preset in the Completion Presets palette at the top right of the Keyframes area, as shown below. Then adjust the
middle keyframes to set the PIP's size and hold duration.
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• To reveal, hold, then expand the PIP, click the "up−flat−up" Completion preset that is directly above the "flat hill" preset in the palette.

• To switch which clip is used for the PIP and background in the SpiceMASTER transition, click the Switch Clips check box in the PIP+ pane.

• You also can move/scale the PIP with the motion controls in your NLE. That can be handy if you have pre−built motion paths there that you like to use. But
SpiceMASTER can independently manipulate the PIP image and mask, and has bezier keyframing for silky−smooth custom acceleration/deceleration of motion or scale.

next page
Advanced Techniques main page
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Advanced Techniques

PIP Examples

View movie at our web site
An organic animated PIP with a multicolor border (that pulses colors over time) frames the high−energy ski action.

View movie at our web site
A soft glow and organic shape adds a unique touch to this PIP. SpiceMASTER also allowed the runner clip to be independently zoomed within the PIP area.

View movie at our web site
This organic PIP flies out of the eye and features a beveled organic edge, then returns to the eye. SpiceMASTER enables you to precisely position such a PIP easily.

View movie at our web site
A traditional frame−shaped PIP has a distinctive touch with SpiceMASTER's edge softening. In this case, the softness is keyframed to decrease over time, using a
Spices\Iris1\Frame C spice.

View movie at our web site
If you have motion paths already available in your NLE, you can apply SpiceMASTER's PIP power to that rather than using SpiceMASTER's PIP controls. In the above
example, a butterfly−like motion path is combined with an OrganicFX\Burst spice (with a hard shadow added for depth) to create a very unusual PIP.

next page
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Advanced Techniques

TUTORIAL: Powerfully Enhance Black & White Mattes

Most editing software can load a black & white (or grayscale) still−image graphic as a matte to show another clip within a shape. But at that point, there is not much more
you can do with the matte. To make even a slight adjustment to its edge, position, shape, etc. you typically need to return to a graphics program and attempt changes by trial
and error −− wasting valuable time.

With SpiceMASTER, you can avoid that tedium. Load the matte and then easily fine−tune it. Reposition or re−scale the matte on the fly, for example, perhaps add a
shadow, glow or softness to the matte's edge. You can even organically animate the edge, if desired. Virtually all effect enhancements in SpiceMASTER are available to
you.

Note that you can also use this feature to add creative, organic edges (fixed or animated) to frame still−photo compositions or picture montages. Or fly and zoom mattes
from 0% to full−screen to create custom iris transitions of logos or thematic shapes.

TUTORIAL

1. Apply the SpiceMASTER transition between two overlapping clips in your timeline. Or apply the SpiceMASTER effect (if available for your NLE) to the TOP clip of the

matte segment. (Click here if you do not know how to apply SpiceMASTER.) If you applied the SpiceMASTER effect, be sure to also activate the alpha channel key in the

TOP clip, if required by your editing software. Avid users: Instead of the above, just apply SpiceMASTER as a segment effect in the top clip of the two overlapping clips in
your timeline.

2. Click the blue Load Saved Settings button in the black bar of SpiceMASTER, then choose the Basic Setup −− Matte file from the Saved Settings folder.

3. Choose a matte, which can be any spice file (especially those of iris−like design) or a custom still−image file. To choose an iris−like spice file, for example, click the
Choose Spice File button, then select a spice from any of the following folders of the Library: OrganicFX\Bursts, OrganicFX\HotIrises, OrganicFX\Plasmas (some), or

Spices\Irises. To choose a custom matte file, Ctrl−click the Choose Spice File button to see an Open dialog box. Choose the black & white still−image graphic on your
drive that you will use as a matte. It will then appear in SpiceMASTER, as shown below.

4. If you are using a spice file to form the matte, move the flat keyframe line for Completion up or down in the Keyframes graph until you have the matte you desire, as
shown below. (For iris−like spices, this will set the size of the iris opening.) If you are using a custom matte file, leave the Completion keyframe line at its default 50%
level.

You are done, unless you want to customize the effect further. To customize the matte's edge, use any of the controls in the Edge or Depth panes. To soften the matte
edge, for example, use the Softness sliders. To animate the matte edge, use the Texture section and activate its Motion slider. Dynamic borders, shadows/glows and
bevels are also available for mattes −− try the various presets provided in the "light bulb" at the right top edge of each effect section.
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Tips

• To reposition or scale the matte, drag the frame outline or center dot in the SpiceMASTER preview (or adjust the Matte sliders in the PIP+ pane).

• To reposition or scale the image within the matte opening, select Choose > PIP (Move Within) at the top of the PIP+ pane, then drag the center dot or surrounding
frame outline in the SpiceMASTER preview (or adjust the Image sliders in the PIP+ pane). This can be very handy to keep a moving subject within the visible matte area.

• To change the opacity of the matte, drag the Opacity slider in the PIP+ pane as desired.

• To keyframe any of the above adjustments, such as to put the matte in motion, first turn on (click) the round keyframe light at the left of the relevant control (such as
Matte > Scale). The keyframe light will be bright and the Keyframes graph for that control will appear. Drag the blue vertical playback marker in the graph to the desired
frame for a keyframe, such as the first key (as shown below). Then do the desired adjustment for the control, such as setting the Scale to 0%. Go to another frame (such as
the last frame), then set different values for the control. Repeat for as many keyframes as desired. For more about keyframing, click here.

• To invert the matte, click the Invert button next to the matte image. (Or press the Alt−9 keys.) To switch which clip appears within the matte in the SpiceMASTER
transition, click the Switch Clips check box in the PIP+ pane.

• For best results, custom mattes should match the frame size of your final output (such as 720x480 pixels for DV). The files can be in any of the following file formats:
BITMAP (.bmp), TIFF (.tif), PNG (.png), PICT (.pct), and TARGA (.tga). For more about creating such files, click here.

• You can also use the alpha channel of a still−image (such as title text) as a custom matte. To do that, follow these steps.

• To create custom iris transitions with any iris−like matte, keyframe the Matte > Scale slider, such as from 0% to 200%. This will zoom the matte shape to fill the
screen, as shown below.

To zoom the inside image with the matte, do the above keyframing, then in the PIP+ pane select Choose > PIP (Move Within) and keyframe the Image > Scale slider
identically to the Matte > Scale slider.
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Click here to see more examples

next page
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Advanced Techniques

Enhanced Black & White Mattes −− Examples

SpiceMASTER can add creative, organic edges to frame clips, whether video or still−photo compositions or picture montages. A huge variety of edge treatments are
possible by experimenting with the Edge and Depth pane controls and presets, as shown above. Texture controls add the organic edge; turning on the Texture > Motion
slider animates the edge.

View movie at our web site
Fly and zoom still mattes from 0% to full−screen to create custom iris transitions of logos or thematic shapes.

Another example of a zoom transition of a matte, using a Photoshop file of an abstract brushed frame, with a white border added in SpiceMASTER. Note how the matte can
zoom in off−center and flow with bezier control.

View movie at our web site
Enhance a ID logo matte with a border and shadow applied in SpiceMASTER, then scale the logo from full−size to a standard semi−transparent corner position.

next page
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Keyboard Shortcuts

Help −− F1
Library −− 1

Undo −− Ctrl−Z
Redo −− Ctrl−X

Control Values
0 −− Home
100 −− End
Decrease by 20 −− Page Up
Increase by 20 −− Page Down
Increase by .1 −− Right or Down Arrow
Decrease by .1 −− Left or Up Arrow

Cycle through controls −− Tab

Spice adjustments
Center −− Alt−5

Clear Rotation −− Alt−6

Keyframes
Select first keyframe −− A
Select prior keyframe −− S
Select next keyframe −− D
Select last keyframe −− F

Playback
Play/Stop −− X
First frame −− Q
Prior frame −− W
Next frame −− E
Last frame −− R

Apply current settings −− Enter
Load Saved Settings −− Alt−L
Save Current Settings −− Alt−S
Clear Settings −− Alt−C
Exit without changes −− Esc

next page
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Index

A GREAT index is crucial to a good help system. Much time and effort has gone into this industrial−strength Index. Click the letter below that corresponds to the first letter of

your search term. A B C D E F G H I J K L M N O PQ R S T U V W XYZ

Entries will then appear like this:  accelerate/decelerate an effect 44 37

Click an underlined number to go to the help page. The most helpful page usually is first. Pages with an image about the topic appear bold (such as 44 above). As an
alternative, click here to view a brief index of just SpiceMASTER controls, commands, etc. organized by where they appear in SpiceMASTER. Sometimes that can be an
even quicker way to find help! This is similar to the context−sensitive help feature of SpiceMASTER, but can be accessed anytime, even when SpiceMASTER is not visible.

A
accelerate/decelerate an effect 44 37
accessing SpiceMASTER's help; how 2
Acrobat PDF print−optimized version of online guide 2
action/direction; reversing 92
activating/jumping to a keyframe 43
active/inactive effect edges; border or softness 20 14
adding a new keyframe 38 41
adding/deleting effects in Library 47
Adobe Premiere / Premiere Pro 4 2
Advanced Techniques 54
advancing the end of an effect earlier 45
All Edges vs. Standard softness 14
alpha channel graphics/logos; SpiceMASTER effects for 59
alpha channel key; activating 4 66 59
alpha wipe files 7
angle/depth of shadow 25
animate an effect/filter/key 55 57
animate an effect/filter; how in your editing software 4
animating different settings of same effect 55
animating only a border 20 52
animating PIPs (picture−in−picture) effects 67
animating spice effects via Texture 17
animating title effects 65
animations (thumbnails) in Library; tips 47
Apply Current Settings button 34
applying SpiceMASTER in your editing software 4
auto−adjusting grayscales in spice for moving/rotation 9
automatic bezier adjustments in keyframes 44
Avid; applying SpiceMASTER in 4
Avid; special techniques 61 64

B
background grid in preview; changing 32 57
Basic Steps 3
Before You Begin 2
beginning of effect; jumping to 32
bevel in an effect 29
bezier acceleration/deceleration 37 44
bezier handle on top of keyframe; activating 45
bitmap (.bmp) files as spices or mattes 71 7 47 52
black & white matte 71 (also see mattes)
blending softness 14
blending title effects 65
blur; softly washing 57
blurriness in PIPs; preferences adjustment 51
border in effects 20
broadcast safe colors; preferences adjustment 51
built−in preview 32 51
bypassing the Library when choosing an effect 7 71

C
centering a spice effect 9
Choose Settings check box 49
choosing a spice file 7
chroma key; animating 66 55
Clear Settings button 34 50 51
clearing a SpiceMASTER effect 34
clearing of keyframes; preferences 51
clearing rotation 9
clip copies; trimmed when animating an effect or key 55 57
clip order during effect, reversing 9 39
color effect/filter; organically flowing/animating 57
color of shadow/glow; changing 25
color palette 20 25

C (continued)
color; keyframing/varying over time 25 57
coloring thumbnails in Library 47
colors of border; changing 20
combining spices or mattes into one effect 52 7
comparing effects in Library 7
Completion keyframing 37
confirm before exiting or clearing; preferences 51
constraining horizontal/vertical movement in keyframer 42
constraining horizontal/vertical movement in spice position 9
control points for border color/opacity 20
converting keyframes to a different type 44
coordinates; entering for a keyframe 42
copy/paste a keyframe or keyframe line 42 45
copyright & credits 1
crawls and rolls; effects for titles 64
Current Frame indicator 32 2
curved keyframe line 44 2
custom black & white matte 71 (also see mattes)
custom files; loading/bypassing the Library 7 71
custom iris transitions by zooming a matte 71 74
customizing display of keyframe graph 45
customizing the Library 47
cutaway look with shadow/glow 25

D
decelerate an effect 44 2
default effect; changing/saving 50 51 7 49
delay the start of an effect; how 45
deleting keyframes 38 41
deleting spices or folders in Library 47
demo version of SpiceMASTER 2
depth via bevel/ripple 29
depth/angle of shadow 25
detail in organic motion; preserving 14
directional dissolves 16 62
distortion/texture effects 52
DPS Velocity 4
drag to zoom in 43
drop shadow 255
dual panes; displaying 13
Duration indicator 32 51
duration of effect 37 32

E
edge texture 17
edges; affecting active and inactive 14
Edition/Liquid 4
effect action/direction; reversing 9
effect speed/pace 37 39
effect/filter/key, animating/flowing 55 57
effects; making your own 52
effects; moving/fine−tuning/enhancing 9 13
end of effect 45 32
entering coordinates for a keyframe 42
example effects 12 16 19 24 28 31 57 62 66 70 74
exiting SpiceMASTER 34 51
eyedropper tool 20 25
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F
factory default settings; reverting to 50 51
fading titles directionally 59
favorite effects 49
Favorites folder in Library; adding effects to 47
field order; preferences 1
filter, animating/flowing 55 57
Film dissolves 12
fine−tune the effect 13
fire−like border edge 24
first/last keyframes; manually adjusting 9
fit Keyframes graph to keyframes 43
flat Completion Preset 37
flipping horizontally/vertically a spice effect 9
floating look with shadow/glow 25
flow an effect/filter/key 55 57
flying PIPs 67 24 32 51
folders in Library 7 47
frame count vs. timecode in frame indicators 32 51
freeze/hold the speed of an effect 39

G
garbage mattes 52
glow; applying 25
gradient border; multicolor 20 24
gradient wipe files 7
graphic as a matte 71
graphics safe area indicator 32
graphics/logos; SpiceMASTER effects for 59 51 32
grayscale image as a spice 7 52 (also see black & white matte)
grayscales; changing 45 9 (also see invert/reverse a spice effect)
grid background in preview; changing 32
grid in Keyframes graph 45

H
handles for adjusting PIPs 32 67
handles for spice/matte positioning 9
help; pop−up text 51
hold/freeze the speed of an effect 39
horizontal "flat" Completion Preset 37
horizontal flipping of a spice effect 9
horizontal/vertical movement, constraining 9 42

I
Image controls in PIP+ pane 67
Import/Export Settings dialog 49
Include Spice check box 49
increasing preview speed/smoothness 32 51
introduction to SpiceMASTER 2
Invert Alpha check box 59 65 66
invert/reverse a spice effect or matte 7 9 39 71
iris custom transitions by zooming a matte 71 74
iris−like spices 9 71

JK
key; alpha channel 4 66 55
keyboard shortcuts 75
keyframe lights 41 45
keyframer 37
keyframing/varying of softness, texture, border, shadow/glow, bevel/ripple
keys; organically revealing/hiding 55

L
Library 47 7
light−bulb section presets 49 14 17 20 25 29
lights to activate keyframing 41 45
Liquid Edition; Pinnacle 4
Load Saved Settings button 49
loading a spice file from the Library 7
logos/graphics 62 (also see titles)
logos; zooming as custom transitions 71
luminance key; animating 55

M
making your own spices/effects 52
manually adjusting the start/end of an effect 9 45
marker in keyframer 37
matching to a color in your scene 20 25
Matte controls in PIP+ pane 9
mattes 71 4 47 52 57
MediaStudio (Ulead) 4 61 64 66 4
Mixer slider 12
More Cool Tips 52
motion for titles or mattes 66 71
motion−tracking a moving subject 57
moving a keyframe precisely 42
moving an effect 9
multicolor gradient border 20 24

N
navigating in the Keyframes graph 43
new keyframe; adding 38 41
NLE, applying SpiceMASTER in, etc. 4

O
off−center spice position 9
opacity of border 20
order of clips in effect, reversing 9 39
organic motion; preserving detail 14
organic reveals of titles, etc. 62
organizing existing effects/favorites in Library 47
Oversize to Spin button 9

PQ
pace/speed of an effect 37 39
pacing; preferences 51
palette 20 25 38
panes; displaying two at once 13
PICT (.pct) files as spices or mattes 71 7 47 52
picture montages 74
Pinnacle Edition Liquid 4
PIPs (picture−in−picture) effects 67 24 32 51
Pixelan Software info 2
play/stop preview 3 32
Playback buttons/controls under preview 32
playback marker in keyframer 37
playing only one spice at a time in Library 47
Please Read FIRST file 2
PNG (.png) files as spices or mattes 71 7 47 52
pop−up text/help 1
positioning/moving an effect 9 67
precisely moving a keyframe 42
Preferences 51 34 32
Premiere or Premiere Pro (Adobe) 4 32
presets; Completion 37
presets 49 14 17 20 25 29
preview background for SpiceMASTER effect; changing 32
previewing 32 51
print−optimized version of online guide 2
Prior Choices button 7
pulse an effect 39 2

R
R (rotation amount of spice image) 9
real−time previewing 32 51
refreshing contents of a Library folder 47
registering SpiceMASTER 2
removing rotation 9
repositioning a spice 9 67
reverse/invert a spice effect or matte 7 9 39 71
reversing clip order in effect 9 39
revert to default keyframe graph 41
RGB values for safe colors; preferences adjustment 51
ripple in an effect 29
rolls and crawls; effects for titles 64
rotate/spin a spice effect 9 45
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S
safe area indicator for titles/graphics 32
safe colors; preferences adjustment 51
saved settings 49
saving favorite effects; tips 49
scaling a PIP 67
scroll bars for Keyframes graph 43 45
scrubbing to play; 32
section presets 49 14 17 20 25 29
settings; animating different settings in same effect 55
shadow transparency in titles; preferences adjustment 51
shadow/glow 25
shimmering edge via texture 19
shortcuts; keyboard 75
slide or drop transitions; bezier control 52
snap to blue vertical playback marker for a keyframe 45
soft/organic PIPs 67 70
softly animate a video effect/filter/key 55 57
softness in an effect 14
Sony Vegas 4 32
speed/pace of an effect 37 39
spice files 71 4 47 52 7
spice files; cool tips 52 71
spice; choosing/adjusting 4 7 45 51 47
SpiceMASTER; introduction/applying 2 4
spin/rotate a spice effect 9
Standard vs. All Edges softness 14
Start menu (Windows) 2
start/end of an effect; manually adjusting 45 32
staying at a frame while adjusting elsewhere 45

T
TARGA (.tga) files as spices or mattes 71 7 47 52
technical support 2
texture 17
thickness via bevel/ripple 29
thickness/width of border 20
thumbnail animations in Library 7 47
TIFF (.tif) files as spices or mattes 71 7 47 52
tiling the Library window 47
Time (in keyframer) 42
timecode vs. frame count in frame indicators 51 32
timing of effect; adjusting 9 59 61
tips; bevel/ripple 29
tips; border 20
tips; keyframer 37 44 45
tips; Library 47
tips; shadow/glow 25
tips; softness 14
tips; spice adjustments 9
tips; texture 17
titles; SpiceMASTER effects for 59 51 32
toolbar in Library 47
tracking a moving subject 57
trailing backgrounds for titles 62
transitions; custom by zooming a matte 71
turning on a control to keyframe 41 45
tutorial; basic 35
tutorials; Advanced Techniques 54
two panes at once; displaying 13
Type 1 vs. Type 2 border 20

U
Ulead MediaStudio 4 61 64 66 4
undo/redo 3

V
value (in keyframer) 37 42
varying an effect quality (see keyframing/varying)
Vegas (Sony or Sonic Foundry) 4 32
vertical flipping of a spice effect 9
vertical movement, constraining 9 42
vertical playback marker 37
vertical resolution of effects; preferences 51
vibrating/pulsing borders 20
Velocity (DPS) 4
video effect/filter; animating 55 57
virtual folders in Library; creating 47

W
water ripple effect 31
Working in the Library 47

XYZ
X,Y (coordinates of spice image) 9
zoom transitions; bezier control of 52
zooming a matte as a custom iris transition 71
zooming in/out of Keyframes graph 42 43
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Index (Organized by Interface Location)

SpiceMASTER main dialog
Help 2
Undo/Redo 3
Dual panes 13
Choose Spice File 7 4
Prior Choices 7
Position 9 67
Spice Controls (Rotate, Center, Clear Rotation, H Flip, V Flip, Invert) 9 7
Auto−Adjust 45 9
Oversize to Spin 9
X,Y (coordinates of spice image) 9
R (rotation of spice image) 9
Mixer slider 12
Load Saved Settings 49
Save Current Settings 49
Clear Settings 34 50 51
Exit Without Changes 34
Apply Current Settings 34

Playback buttons/controls under preview 32

Keyframes area
Keyframes label area 37 45
[gray buttons] 43
Completion Presets palette 38
Zoom buttons 43
Scroll bars 43 45
Vertical playback marker 41 42 45
[right−click on graph/line for pop−up menu] 38 41 42 45 43 44 45 59 61

Edge & Depth panes
Softness 14
Texture 17
Border 20
Shadow/Glow 25
Bevel/Ripple 29

PIP+ pane
Choose > PIP 67
Choose > PIP (Move Within) 67
Choose > Move Matte 52 9
Choose > Title/Alpha 59 65
Choose > Title/Alpha on Black (or White) 59 65
Preview Size button 32
Matte > Scale 71 9
Matte > X (or Y) 9
Image > Scale (or X or Y) 67
Image > Opacity 52 67
Show Handles check box 32
Show Safe Areas check box 32
Invert Alpha check box 59 66
Switch Clips check box 67 71

Prefs (Preferences) Pane 51 32

Library interface 7 47

go back to main Index page
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